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ABSTRACT 

 Much time and effort has been spent attempting to discover the best approach to the 

problem of microcontroller education. In electrical and computer engineering (ECE) curricula, 

much consideration is given to the topic of hardware interfacing. For the potential computer 

engineer, this is an important concept to master, in view of its significance in the current state of 

technology. 

 Unfortunately, in many curricula, the student is introduced to digital circuitry and 

immediately thrust into interfacing, due to the pressures of time in a traditional four-year 

academic career. Often, the student’s understanding of the basics of microcontroller operation 

and control are not to a satisfactory level before the student is expected to use a processor to 

control other, more complex, systems. This research attempts to compile a solution to allow a 

student to be well versed in microcontroller operation while he or she begins to work with 

additional interfacing requirements. 

 A prototype printed circuit board (PCB) has been assembled that works in close harmony 

with the National Instrument ELVIS prototyping system that attempts to alleviate this problem. 

This prototype daughter card rests on top of the breadboarding area of the ELVIS system and 

allows the student full access to all of the tools and contacts that would be available without the 

card. The student is required to make the connections necessary for a fully-functional 

microcontroller system, as opposed to the method of using a pre-fabricated microcontroller 

development board. When using a board such as this, the student may not fully understand the 
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individual components and their interconnections. This process of connecting components 

requires the student to understand the physical interface between the microcontroller and the 

peripheral device(s). 

 Anticipated results from this research are an increased aptitude in peripheral interfacing 

and a greater level of success in more complex courses following in the curriculum. By allowing 

the student to interact with the interfacing process on a lower level, a more complete 

understanding of microcontroller-based systems and peripheral interfacing is obtained.  
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CHAPTER 1 

BACKGROUND AND MOTIVATION FOR MCUPC DESIGN 

 Much time and effort has been spent attempting to discover the best approaches to the 

problem of microcontroller education. The methods and processes of teaching microcontrollers 

are important components to the education of potential electrical and computer engineers and 

computer scientists. Across the variety of institutions that teach these concepts, the methods 

differ. However, the main focus and outline of the topics that are necessary to cover at this level 

stay the same. 

 During a traditional prerequisite flow for computer engineering students in an 

undergraduate curriculum, students tend to study microcontroller topics in a standard order and 

transition. At The University of Alabama, students begin their work toward designing 

microcontroller systems in ECE 285, which covers C programming. Students then continue their 

work toward microcontroller systems in the ECE 380 course. According to [1], this course 

covers topics such as number systems, Boolean algebra, and combinational and sequential logic 

systems. This course lays the groundwork and prepares the student for the first microcontrollers 

course that is labeled ECE 383. This course covers microcontrollers, assembly-language 

programming, interrupts, hardware interfacing, and other related topics. Beyond these courses, 

the students are expected to be familiar enough with microcontrollers and peripheral interfacing 

topics to put their skills into practice in courses such as ECE 480, ECE 484, and ECE 486, which 

discuss microcontroller systems at a much more complex level [2, 3]. 
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 This is the traditional format and progression of a normal undergraduate curriculum of 

ECE education. This progression is fairly rigid, due to the fact that students must master this 

introductory material in order to be successful with more complex microcontroller systems. In 

the Department of Electrical and Computer Engineering at Iowa State University, the first course 

that is taken by undergraduate ECE students is at the sophomore-level called CPRE 288: 

Embedded Systems I: Introduction. This course covers embedded hardware models, embedded 

programming at the C and assembly levels, and input and output (I/O) interfaces of simple and 

advanced peripheral devices. Only then does the student move on to the more difficult courses of 

CPRE 488 and CPRE 588, Embedded Systems Design and Embedded Computer Systems, 

respectively, with the latter being a graduate level course. These courses cover material that 

requires the prerequisite material of the sophomore-level course, very similar to the relationship 

between ECE 383 and the senior-level courses ECE 480, ECE 484, and ECE 486 at The 

University of Alabama [1, 2, 3, 4]. 

 As discussed in this document, as well as in [5], the upper-level courses assume a 

sufficient background in the subjects relating to hardware and peripheral interfacing, so these 

topics must be covered at the beginning of the computer engineering sequence of an ECE 

curriculum. These introductory courses familiarize the students with semi-complex 

microcontroller systems and their design and construction. The students then enter the terminal 

courses with a good foundation from which to work.  

 In an ECE undergraduate curriculum, and more specifically, in this introductory 

microcontrollers course, the methods and approaches to teaching the material have more freedom 

than the material itself. The microcomputer engineering innovation system, suggested by [6], 

discusses four main components to the systematic design of a microcontrollers curriculum: 
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theoretic teaching, experimental teaching, engineering design and practice, and scientific 

activities outside of the course. The first three components apply to the introductory 

microcontrollers course, itself. The fourth pertains to elective courses that may be taken 

subsequently from the first. Practically, these three components could be described relating to the 

course as lectures, examples, and laboratory assignments, respectively. 

 Though a traditional course may be structured around these three methods of instruction, 

the tools that are used to implement the design are widely left up to the discretion of the 

institution. Lectures are fairly structured and inflexible as the material must be discussed before 

any hands-on approach may be taken. During these lectures, and perhaps at the leisure of the 

student, examples may be given that guide the student toward the desired results of the 

discussions in a guided hands-on experience. These examples, again, are fairly set in nature due 

to the administrator of the course dealing with many students at once at an elementary level. 

However, the laboratory assignments associated with the course provide an area of much-needed 

flexibility to the instructor. The assignments can be molded and shifted by session to provide the 

users with a unique and fresh laboratory experience. 

 The issue of difficulty in this sequence of topics being used in this type of course format 

comes when the student is faced with the task of working through laboratory assignments that 

cover assembly language programming, to some complexity, and microcontroller-peripheral 

interfacing at the same time. In Fall of 2003, the Electrical and Computer Engineering 

Department at Mississippi State University began a process to address this issue. Previous to this 

time, the introductory microcontrollers course was set up in this fashion, with a heavy emphasis 

on assembly language programming. The course was modified to discuss assembly coding, but 

to have the majority of the focus of the topics geared toward embedded system concepts and 
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design prototyping, including hardware interfacing, while using C programming as the major 

language of choice. By incorporating a focus such as this, more complex interfacing assignments 

are able to be completed by the students as laboratory assignments. In the words of the authors of 

[7], “grasping the hardware interfacing issues is difficult enough without adding the extra 

complexity of coding applications in assembly language.” 

 To begin building and designing a course to include all aspects of instruction (lectures, 

examples, and laboratory assignments), the proper hardware must be selected to tailor the 

students’ assignments. In many cases, as discussed in [7], a large microcontroller unit (MCU) 

development kit is selected that includes the microcontroller and all peripheral devices on board. 

This is the design format that the Department of Electrical and Computer Engineering at The 

University of Alabama has been using in previous years. The Dragon12-Plus MCU from 

EVBplus has been the main hardware that laboratory assignments for ECE 383 have been built 

around [2, 3, 8]. This may have contributed to a decline in the grasp of the fundamentals of 

microcontrollers and peripheral interfacing. Possible reasons could include the absence of the 

connections in physical sight of the user when working with the MCU, or possibly the sheer 

magnitude of the device that the student is working with. The fact that the students working the 

assignments have not been making the physical wiring connections from the microcontroller to 

the peripheral device(s), because of the monolithic nature of the MCUs, may be contributing to 

this decline in peripheral interfacing aptitude. If the students were required to make these 

connections themselves, it is possible that a more fundamental understanding of these topics 

would be obtained. 

 Recently, in an effort to increase student knowledge and understanding of microcontroller 

systems, and also success in the related courses, other options have been sought for the main 
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equipment to make use of in the laboratory for the course. Grupta and Chew [9] discuss the 

process that instructors from Massey University in New Zealand went through when searching 

for this same solution. In this article, a list of desired characteristics for this MCU is laid out and 

discussed. The instructors chose the SiLab C8051F020 microcontroller due, in no small part, to 

time and budget constraints. Because the particular model they selected contained no more 

peripheral devices than a pushbutton and an LED, an expansion board was designed. 

 The researchers from Massey University designed an expansion board to build on top of 

the SiLab MCU they had already purchased, in order to add the functionality of all the peripheral 

devices they desired. A similar design experience took place at “Transilvania” University in 

Brasov, Romainia [10]. The design in this article has particular significance because it follows 

the same general format of the design discussed from The University of Alabama, though for 

much different purposes. Students in the related department at “Transilvania” University are 

familiar with the National Instruments (NI) Educational Laboratory Virtual Instrumentation Suite 

(ELVIS) from previous coursework in their curriculum. Students at The University of Alabama 

use this NI ELVIS system in their undergraduate courses, up to, and including, ECE 380, the 

major prerequisite course for ECE 383 [2, 3]. 

 The department in question, from [10], also makes use of a daughter card called the 

Freescale Microcontroller Student Learning Kit (MCU SLK). This kit works in tandem with the 

second revision of the NI ELVIS hardware, the NI ELVIS II. The MCU SLK is basically a 

daughter card that also accepts stand-alone modules that, when connected to the MCU SLK 

through a 40-pin connector, have access to all of the NI ELVIS II’s and the MCU SLK’s 

associated peripheral devices. This flexibility is invaluable to a setting such as the one under 

discussion in this document, a laboratory for an introductory microcontrollers course. 
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 This document introduces the solution that The University of Alabama is attempting to 

implement into its undergraduate ECE curriculum. The solution is a daughter card that will 

connect directly to the NI ELVIS workstation and, thus, allow access to the entirety of the 

instrumentation suite offered by it. This card, called the Microcontroller Unit Peripheral Card 

(MCUPC), attempts to address the issues that are facing potential engineers in need of solid 

instruction in microcontrollers and peripheral interfacing, without coming at the expense of 

familiarity with advanced assembly programming techniques.  
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CHAPTER 2 

THE MCUPC DESIGN 

The MCUPC is designed and built to help alleviate a subset of the problems that are 

being faced with the education of potential electrical and computer engineers. Potential users of 

the MCUPC are facing issues relating to the education of microprocessors and their associated 

interfacing with peripheral devices such as lack of advanced assembly programming skills, lack 

of understanding of peripheral interfacing at the hardware level, and a deficiency in the area of 

printed circuit board (PCB) design. It is the belief of the researchers that these concerns may be 

due, in some amount, to the use of monolithic MCU-based boards in the laboratory setting of 

courses designed to address this topic in many curricula at the present time. To address these 

areas of concern, the MCUPC system has been designed. It is the hope of the researchers that the 

implementation of this system into ECE curricula will help improve the education in these areas. 

 In a traditional undergraduate ECE curriculum, the laboratory portion of the course 

relating to microprocessors and their associated interfaces with peripheral devices may be 

tailored to and designed around instrumentation such as the NI ELVIS. An example of this type 

of course design is currently in place at The University of Alabama. The textbook proposed for 

use in this curriculum is the same textbook authored by members of the faculty of and currently 

used in the Department of Electrical and Computer Engineering at Mississippi State University 

[11]. 
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 The majority of laboratory assignments that would be in use relating to a course designed 

this way would be heavily geared toward building prototypes of digital systems while taking 

advantage of the instrumentation features of the NI ELVIS workstation. Because of the sheer 

nature of a course of this type, there would typically be many peripheral devices in use to 

highlight different aspects and methods of the microprocessor-peripheral device interfacing 

process. The set of components in chapter three of this document is an example of such a subset 

of components needed. There would be many designs that the user would be required to 

prototype and build during the course of the laboratory experience. Though this is a skill that is 

crucial to a user’s understanding of and experience with digital systems, it surely is an expertise 

that should be established well before he or she begins working with microprocessors and more 

complex digital systems. Understandably, the large portion of the user’s laboratory experience 

would not be geared toward peripheral interfacing, but toward prototype design and construction. 

 However, to completely take away the aspect of breadboarding and prototype 

construction would be detrimental to the user’s knowledge of the foundational principles of 

peripheral design itself. The process of breadboarding and constructing a prototype of a digital 

system leads the designer to deeper knowledge and understanding of the system. A balance 

between requiring the user to construct their circuit prototypes and the system inherently 

providing these circuits for the user must be maintained. This balance must allow the user 

enough opportunity to construct prototypes using a breadboarding method but also be focused on 

the design process more than circuit construction. 

 By allowing the user to construct their own breadboarded prototypes, they are able to 

more fully understand the components of a microprocessor-peripheral device interface. As 

opposed to the monolithic MCU development board, the user is aware of all connections 



9 
 

between the devices and better understands the needs that are met with each connection. By 

designing the MCUPC with these goals in mind, stability between prototype construction and 

knowledge and awareness is met. By incorporating the hardware that the user is already familiar 

with from prerequisite coursework, the user obtains a more rapid understanding and practical 

work experience with the new hardware that is being introduced. The MCUPC builds upon the 

functionality of the NI ELVIS system by fully integrating the features with which the user has 

previously worked. 

The MCUPC is a PCB that inserts into the prototype area of the NI ELVIS workstation 

and can fully connect to the functions and tools that are offered by the workstation suite. The 

MCUPC is built as a workbench for a traditional laboratory setting that is used with a course that 

covers the basics of microcontrollers and peripheral interfacing. It contains sockets for a 

microcontroller in a 28-pin (or smaller) dual-inline package (DIP) as well as several components 

of various sizes. A standard set of integrated circuits (ICs) that comprise a basic introduction to 

peripheral interfacing is included as a suggested group of components that comprise the MCUPC 

laboratory system. 
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CHAPTER 3 

IMPLEMENTATION OF THE MCUPC DESIGN 

SECTION A. ADVANTAGES OF THE MCUPC 

The Microcontroller Unit (MCU) Peripheral Card (MCUPC) is a component that has the 

potential to enhance students’ microcontroller laboratory education experiences in multiple 

ways. By incorporating a system that meets the needs discussed earlier in this document, 

microcontroller education is improved which, in turn, improves the capabilities of students’ who 

go through the curriculum. The MCUPC offers students the opportunity to obtain a more detailed 

knowledge of the relationship between microprocessors and their associated peripheral devices. 

An important deciding factor in choosing laboratory equipment for a particular 

department or institution is the tradeoff between cost and usability. In other words, for a system 

to be deemed as useful, the cost must not outweigh the flexibility and addressed measures of the 

system. Careful consideration of this idea was made throughout the design process of the 

MCUPC system. 

The MCUPC laboratory system offers the user with a simple arrangement of preselected 

components that can be soldered directly to the board or used with a socket. This flexibility in 

design allows the user to decide on the particular set of peripheral devices and control units to 

use themselves. By implementing the components as sockets on the peripheral board, the user 

can make these decisions independently and tailor the operation of the system to their specific 

needs. Alternatively, the user has the ability to use the predefined set of components that are used 
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in the prototype of this system and solder them directly to the PCB. The flexibility of this design 

gives the user many options with regard to how an individual department will make use of the 

system. 

The MCUPC laboratory system addresses many of the areas of microcontroller education 

that are necessary in a standard electrical engineering or computer engineering curriculum. The 

proposed set of peripheral components of the system combine to address a wide range of 

interfaces that an engineer might see in their career after education. The set of components lean 

heavily to the Inter-Integrated Circuit (I2C) interface but also makes use of the Serial Peripheral 

Interface (SPI), Pulse-Width Modulation (PWM), matrix output standard to a keypad hardware 

component, and a custom interface discussed in the liquid-crystal display (LCD) module 

documentation. Because of the wide variety of interfaces that are available on board the 

MCUPC, the student is given a wide basis of peripheral interfacing instruction in the laboratory 

setting. 

The MCUPC laboratory system is composed of a custom build of a PCB coupled loosely 

with the set of components that a student would be using in such a setting regardless. If a student 

would be required to purchase the materials of the laboratory then the department could spend 

some amount of money on a variable set of PCBs to be used with this system. In this case, the 

cost of the system to the department and the student would not be so much as to outweigh its 

positive aspects. In the extreme case that the student or the institution needed to pay for the entire 

system individually, the cost is still manageable. The complete breakdown and cost of the 

MCUPC system is addressed elsewhere in this document. 

As previously discussed, the MCUPC was designed to assist institutions in better 

educating their students majoring in electrical engineering and computer engineering in the area 
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of microcontrollers and peripheral interfacing. Instead of hiding the traces on the PCB when 

routing the design, care was taken to attempt to keep the traces visible to the user. This further 

highlights the student’s need to understand the reasoning for the connections that they are 

making to the various peripheral devices from the microprocessor unit. The image in Figure 1 

shows a basic PCB. Easily noticed is the method of routing that the designer used. No routes 

and/or traces can be easily seen from looking at the top of the PCB, the normal perspective of the 

user. 

 

Figure 1. Example PCB with no recognizable traces. 
 

If all of the components used in the MCUPC laboratory system were traced in such a 

fashion as the example shown in Figure 1, the student would have a difficult time recognizing 

what connections were being made by the routes. If one of the major goals of the MCUPC 

system is to remove the monolithic view of microcontroller peripheral boards by students in 

microcontroller education courses, then these traces should be evident. The student should 

immediately know, upon viewing the system, what connections are available and how those 

connections can be made. Figure 2, below, shows a small subset of the MCUPC with the 

component in view soldered directly to the board. For the student to make connections to this 

component, they must use the header sockets on either side of the DIP. 
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Figure 2. Subset of MCUPC showing traces. 
 

Using a tracing and routing method closer to the method used to create the PCB in Figure 2 

rather than Figure 1 helps the end user to more fully visualize and understand the connections 

that are being made between the components or headers in question. 

National Instruments offers a design and prototyping platform that is currently in use in 

many engineering education institutions across the world today. The NI ELVIS is a workstation 

that integrates twelve very common instruments into one system that can be used in a small 

form-factor in one place. The ELVIS workbench integrates a digital multimeter, oscilloscope, 

function generator, variable power supply, bode analyzer, dynamic signal analyzer, arbitrary 

waveform generator, digital reader, digital writer, impedance analyzer, two-wire current-voltage 

analyzer, and a three-wire current-voltage analyzer in one system that can be used on the same 

platform. The ELVIS system is relatively easy to use, integrated with Multisim, a popular 

software package that simulates circuits through SPICE simulation, and very flexible regarding 

its use with other software packages and purposes [12]. 

At The University of Alabama, the undergraduate electrical engineering and computer 

engineering curricula are currently patterned in the format of the subset of the flowchart shown 

below, in Figure 3. The course that most closely matches the microcontroller and peripheral 

interfacing course in question is listed with the course number ECE 383 [1]. 
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Figure 3. Subset of electrical engineering flowchart displaying prerequisite flow [2, 3]. 
 

In Figure 3, boxes represent courses and arrows represent the prerequisite requirements 

from one course to another. As can be seen in Figure 3, the single prerequisite from the ECE 383 

Microcomputers course is ECE 380, a course covering digital logic theory. Indirectly, the set of 

prerequisites also include the ECE 285 Programming for ECE course that covers ANSI-standard 

C programming. For the direct prerequisite, ECE 380, extensive laboratory work is completed 

using the NI ELVIS workstations. Students are required to complete multiple laboratory 

assignments that make use of several different aspects of the ELVIS system. However, no 

daughter card system is ever used in this ECE 380 course. Thus, the prerequisite knowledge of 

the NI ELVIS system is in place once students enroll in the ECE 383 Microcomputers course. 

Any work with the MCUPC system builds upon this predefined knowledge [1, 2, 3]. 

There exists a set of instrumental tools that a laboratory environment needs to be able to 

operate efficiently. One of the advantages of the NI ELVIS workstation and laboratory system is 

the implementation of these set of tools in one suite. When using the MCUPC, the capability of 

using these tools remains available. In Figure 4, a view of the top workbench prototyping area of 

the NI ELVIS workstation is shown. The outer smaller headers hold the connection points for the 

tools of the instrumentation suite. The inner larger breadboarding area has no internal 

connections and is only meant as a free prototyping area. A view of the entire MCUPC can be 
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seen below in Figure 7. The outer four two row by twenty-seven point headers serve as the 

connection points to these tools in the instrumentation suite. The headers plug in the outer rows 

of the NI ELVIS connection headers. Not only do these headers serve as connections to the 

virtual instrumentation toolsuite, but they also serve as physical mounting and support points for 

the MCUPC [12]. 

 

Figure 4. Overhead view of NI ELVIS workstation. 
 

When designing a system that is intended for multiple users in multiple environments, 

care must be taken to design a system that has enough flexibility to meet the needs of all users in 

all environments. In the case of the MCUPC, the system is intended to be used with the 

Microchip® Microstick development kit. However, if a department or institution desired to use 

the MCUPC in a way that it was not specifically designed for, it has the flexibility to work in this 

fashion [13]. 

From Figure 5, there are two innermost headers that correspond to the footprint of a 28-

pin SPDIP socket. If the user desired to use a simple microprocessor, and not the Microstick 

itself, the institution could use this pair of sockets along with the outermost headers as the user 

pins. Alternatively, if the user wished to use the Microstick®, the middle headers could be used 

along with the outermost headers as the user pins. 
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Figure 5. Image of microprocessor unit orientation on MCUPC. 
 

The flexibility that this system offers is a highly desirable characteristic. Not only is the 

MCUPC available and conducive to a standard laboratory setup similar to the one that is 

intended, but it is also possible for it to be used with any laboratory setup and component list, 

provided it can be manufactured and purchased in the same footprint as the 28-pin shrink-plastic 

DIP (SPDIP) [14]. 

SECTION B. COMPONENTS SELECTED 

The Dragon12-Plus MCU from EVBplus/Wytec is the trainer module that has been used 

at The University of Alabama previously for the laboratory instruction in the ECE 383 

Microcomputers course. This laboratory instructional system has been used to teach assembly 

language programming, peripheral interfacing, and modular system design. The system itself is a 

16-bit MCU designed and built for an academic environment. An overhead view of this system 

can be seen in Figure 6 [8]. 

When designing the MCUPC, a major factor in component and peripheral selection was 

to obtain a set of components that would allow a wide range and variety of interfaces to be used 

in the instructional process. For every component that was used in the ECE 383 course to instruct 

some interfacing concept, a corresponding component was selected. Because of this design 
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specification, the same instruction can take place in an environment more conducive to 

microcontroller instruction. 

 

Figure 6. Overhead view of Dragon12-Plus MCU from EVBplus/Wytec. 
 

 

Figure 7. Overhead view of unpopulated MCUPC daughter card – Revision 2.0. 
 

The headers that were selected are manufactured by Sullins Connector Solutions. With a 

standard row spacing of 0.100 inches, or 2.54 millimeters, the headers can successfully and 

properly mate together. The headers rise above the PCB at a height of 0.335 inches, or 8.5 

millimeters. Similarly, all headers used on the MCUPC rise above the PCB at this same height. 
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Uniformity keeps the wiring that will be completed by the user during laboratory assignments as 

clean as possible [15]. 

By using the virtual instrumentation suite of the NI ELVIS system via these connection 

points, the MCUPC offers a wider capability of functionality than it would otherwise. The user is 

given access to the toolsuite that can be used throughout the design and prototyping process. As 

an example, the function generator coupled with the oscilloscope would be a pair of tools that 

would be difficult to use if not integrated into the system. All twelve systems can be used in any 

combination during the operation of the MCUPC system. The headers that support the PCB give 

the user this capability [12]. 

To provide some usefulness to the user of a laboratory system, a prototyping area must be 

afforded to the user. In the case that the institution wishes to implement an assignment or project 

involving a set of components that are not included with the original MCUPC, a breadboarding 

area is provided for the user to make use of at his or her discretion. This breadboard is not a large 

prototyping area, but it is sufficient for the application of the MCUPC. The flexibility that a 

breadboard prototyping area adds is well worth the physical footprint that it takes from the PCB. 

The Dragon12-Plus system offers a prototyping area for these reasons. Figure 6 shows 

the breadboarding area on the right half of the MCU system. Because of the monolithic design of 

the Dragon12-Plus system, there is no need to offer the user connection points from each 

individual component on the PCB. Therefore, there is ample room to include a much larger 

prototyping area that even extends over and completely covers some components. The nature of 

the design of the MCUPC does not allow this characteristic, and thus, the design retains the 

characteristics of the NI ELVIS workstation that make it so advantageous [12, 8] 
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The solderless breadboard that was chosen to be implemented with the MCUPC is the 

270-Point Breadboard item manufactured by Pololu. This component has a rectangular physical 

footprint with the dimensions of 3.25 inches by 1.75 inches, or 82.55 millimeters by 44.45 

millimeters. This component can be seen in Figure 8. There are four mounting holes that 

comfortably fit screws to fit the standard 2-56 screw size. These are the screws and nuts used to 

mount the breadboard to the PCB [16]. 

 

Figure 8. Pololu 270-Point Breadboard. 
 

The component consists of two bus lines that span the length of the board on either side, 

allowing the user to use them at their discretion, including the possibility of being used as the 

standard power and ground lines. There are 23 rows of pins allowing the use of several different 

configurations of ICs. If an institution desired to use a microprocessor with this system that was 

not available in a 28-pin (or smaller) SPDIP, it could be conveniently mounted on the 

prototyping area and used appropriately. This is one more aspect of the flexibility and 

adaptability of the MCUPC [14, 16]. 

As one of the methods of receiving input from the user when utilizing the MCUPC, a 3x4 

matrix output keypad is provided. One of the main topics of microcontroller usage and peripheral 
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interfacing is handling different kinds of user input. One of the inputs offered with the MCUPC 

is the matrix keypad shown in Figure 9. Using this matrix output from the keypad, the user of the 

laboratory system will be required to create semi-complex algorithms to handle button presses, 

debouncing, and input priority. 

 

Figure 9. Futurlec small 4x3 matrix-output keypad. 
 

The Dragon12-Plus implements this component using a 4x4 matrix output keypad that is 

built into the MCU PCB itself. Using a 4x4 keypad, sixteen digits can be used, and thus, the 

system can receive all hexadecimal characters from the user, or any other combination of sixteen 

input characters. Procuring keypads with a small enough footprint to be used in the MCUPC 

system is difficult [8]. 

Futurlec Electronic Components offers a Small Keypad that boasts a smaller physical 

footprint of 2.008 inches by 2.520 inches, or 51 millimeters by 64 millimeters. The tradeoff for 

the size of the physical footprint is the fact that only twelve keys are implemented in a four row 

by three column fashion. Using this format, all ten decimal digits could be used with two keys 

being reserved for alternate characters. A standard telephone format would include a star (*) and 

a pound (#) character. 
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The output of the Futurlec Electronic Components Small Keypad is a standard matrix 

keypad output. Because there are four rows and three associated columns, there are seven pins on 

the matrix output of the keypad. Pins one through four are connected to rows one through four, 

respectively, and, likewise, pins five through seven are connected to columns one through three, 

respectively. There are many ways that a matrix-output keypad, such as this one, could be used. 

The simplest way to connect and make use of this while coding would be to set up the four rows 

as outputs of the microcontroller and the three columns as inputs. At a speed that is quick, 

relative to the length of a button-press, power can be applied to each row output. When a column 

successfully outputs a high voltage back to the microcontroller while power is being applied to a 

row, the specific key information can be deduced. Similarly, the three columns could be powered 

by the microcontroller and the four rows could be monitored. Also, a more advanced algorithm, 

and, possibly, one that is more functional, could be an interrupt-based system that only responds 

to the I/O when necessary [17]. 

The Dragon12-Plus MCU board is built around the Motorola MC9S12DG256CVPE 

microprocessor system. Because it is implemented in a quad-flat pack (QFP) package, it has 

many pins available for use, much more than a DIP package would have available. In fact, of the 

one-hundred-twelve pins available on the package, ninety-one of them are configurable for user 

I/O applications [8]. 

The MCU of choice for the MCUPC is the Microstick development kit manufactured by 

Microchip. The Microstick, which makes use of the PIC24HJ64GP502 microprocessor, has 

sixteen remappable pins for use with input and output, but only seven of these pins are five volt 

tolerant. Because a larger quantity of input and output pins will frequently be necessary, a 

separate IC is implemented to offer this functionality. Also, the pin expander chosen uses an I2C 
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interface, which allows the user an avenue for using this method of communication and 

interfacing [14]. 

Microchip Technologies offers an I/O pin expander IC called the MCP23017 16-Bit I/O 

Expander with Serial Interface. This is the pin expander used to implement the MCUPC 

laboratory system. It can be manufactured in multiple packages including the 28-pin SPDIP 

package which is shown in Figure 10. 

 

Figure 10. Microchip Technology Inc.’s MCP 23017 16-Bit I/O Expander with Serial Interface. 
 

The pinout diagram for the MCP23017 Pin Expander is shown in Table 1. As can be 

seen, pins twelve and thirteen are the clock and data pins, respectively, for use with the I2C 

interface. Pins nine and ten are the power and ground pins and pins fifteen through seventeen are 

the hardware address pins that are biased externally from the IC itself. 

Table 1. Pinout Diagram for the Microchip MCP23017 16-Bit I/O Expander [18]. 
 

Pin Name Pin Number Pin Type Pin Description 
GPB0 1 I/O Bidirectional I/O pin. 
GPB1 2 I/O Bidirectional I/O pin. 
GPB2 3 I/O Bidirectional I/O pin. 
GPB3 4 I/O Bidirectional I/O pin. 
GPB4 5 I/O Bidirectional I/O pin. 
GPB5 6 I/O Bidirectional I/O pin. 
GPB6 7 I/O Bidirectional I/O pin. 
GPB7 8 I/O Bidirectional I/O pin. 
VDD 9 POWER Power. 
VSS 10 POWER Ground. 

NC/CS 11 NC Not connected. 
SCL/SCK 12 INPUT Serial clock input. 
SDA/SI 13 I/O Serial data I/O. 
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NC/SO 14 NC Not connected. 
A0 15 INPUT Hardware address pin. 
A1 16 INPUT Hardware address pin. 
A2 17 INPUT Hardware address pin. 

RESET 18 INPUT Hardware reset. 
INTB 19 OUTPUT Interrupt output for PORTB. 
INTA 20 OUTPUT Interrupt output for PORTA. 
GPA0 21 I/O Bidirectional I/O pin. 
GPA1 22 I/O Bidirectional I/O pin. 
GPA2 23 I/O Bidirectional I/O pin. 
GPA3 24 I/O Bidirectional I/O pin. 
GPA4 25 I/O Bidirectional I/O pin. 
GPA5 26 I/O Bidirectional I/O pin. 
GPA6 27 I/O Bidirectional I/O pin. 
GPA7 28 I/O Bidirectional I/O pin. 
 

Pins one through eight and pins twenty-one through twenty-eight are used as the 

bidirectional I/O pins and can be written or read by the master of the I2C bus, which in most 

cases will be the MCU on board the MCUPC. The implementation of this IC is advantageous 

because the user is essentially offered sixteen I/O pins for the use of two on the microprocessor. 

If necessary, the user could add a separate MCP23017 IC using the breadboarding area and 

extend this advantage even further [18]. 

The Microstick microprocessor development kit has built-in support for the I2C interface 

so that the user is not responsible for the physical implementation of the clock and data signal. It 

is instructional for a student to work with this interface because a fundamental knowledge of the 

communication is necessary for successful operation; however, the special function registers of 

the I2C module allow easy and direct access to all control and status operations of this protocol. 

A simple example of sending a byte of data using this module on the PIC24HJ64GP502 can be 

seen in Figure 11. For the sake of completeness, an example of setting up the I2C module on this 
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processor is shown in Figure 12 as well. Throughout this code, the I2C1TRN, I2C1STATbits, 

I2C1BRG, and I2C1CONbits definitions are preprocessor definitions designed to be mapped 

directly to the control and status registers of the built-in I2C module of the microprocessor [14]. 

 

Figure 11. Example code sending a byte of data to an I2C slave device. 
 

 

Figure 12. Example code setting up the I2C interface on the PIC24HJ64GP502 microprocessor. 
 

Use of the MCP23017 provides the user with reasonable practice using the I2C 

communication interface as well as the flexibility of having a larger set of bidirectional I/O pins 

once this method of communication is in place and operational. 

Several factors went into the choice of what microprocessor to include in the MCUPC 

laboratory system design. First, and, arguably, most importantly, the resultant addition to the cost 

of the entire system must be taken into account. With an instructional laboratory system such as 

this, reducing the cost of each component as much as possible is important. In the case that the 

institution provided this component, or in the case that the user was asked to provide this 

component individually, the cost must be a manageable amount. 
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Functionality is also an important factor. A microprocessor or microcontroller unit must 

be selected that implements the functions necessary to meet the needs of the specific laboratory 

course unit for which the system is being used. The MCUPC is intended to meet the needs of a 

course covering the basics of microcontrollers and peripheral interfacing, thus the MCU must 

provide the capability of handling and working with multiple communication protocols and types 

of interfaces, such as SPI, I2C, and other communication protocols. 

A third important factor for choosing the microprocessor unit is the flexibility of the 

physical footprint trading off with the number of bidirectional I/O pins that are available in a 

hardware package implementation. Because of the size limitations of the MCUPC, the physical 

footprint of any component that is selected is considered so that the largest set of components 

possible can be included with the system. Also, the number of I/O pins available in a specific 

package is important because of the extensive peripheral interfacing done with this system. 

As a part of the Dragon12-Plus MCU system, the Motorola MC9S12DG256 MCU is 

included in a one-hundred twelve pin low-profile quad flat package (LQFP). Figure 6 shows the 

overhead view of the Dragon12-Plus board previously used at The University of Alabama. The 

MCU is mounted directly underneath the breadboard prototyping area. All pins from the LQFP 

package can be connected to via the headers surrounding the prototyping area [8]. 

Table 2. Comparison of microcontroller selection. 
 

Microcontroller PIC24HJ64GP502 MC9S12DG256CPVE 
Cost $6.66 $23.49 

Related Connectivity I2C, SPI I2C, SPI 
Program Memory Size 64K 256K 

I/O Pins 21 91 
Package 28-DIP 112-LQFP 
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Based on all factors considered for the choice of the MCU to be used in the MCUPC 

laboratory instructional system, the PIC24HJ64GP502 microprocessor from Microchip 

Technologies was selected. A comparison of the microcontrollers of the two systems can be 

shown in Table 2, above. This microprocessor IC can be seen in Figure 13 mounted on the 

Microchip Technologies Microstick development kit. This kit is USB-powered and includes an 

on-board debugger and programmer using this connection. The Microstick can be used with the 

aforementioned processor or any other processor that can be manufactured in a 28-pin SPDIP, as 

discussed earlier in this document. The development kit, or the microprocessor alone, can be 

used with the MCUPC as there are adequate sockets to support them both. 

 

Figure 13. Microstick development kit from Microchip Technologies. 
 

The pinout of the PIC24HJ64GP502 microprocessor is shown in Table 3. An asterisk (*) 

beside a pin number identifies that pin as +5 volt tolerant. The development kit contains direct 

connections to the pins of the microprocessor so the pinout is essentially the same. NC indicates 

that the pin is not connected in the development kit socket. Pins with more than one function 

only have a description for the first function listed. Any pin with the function RAX or RBX, 

where ‘X’ represents a number, is a pin that can be configured for bidirectional input and output. 

However, the voltage tolerances of these pins vary as discussed earlier. A standard library is 

included with the PIC24H microprocessor and is available for use [14]. 
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Table 3. Pinout Diagram for the PIC24HJ64GP502 microprocessor [14]. 
 

Pin Name Pin Number Pin Description 
MCLR 1* Master Clear input 

AN0/VREF/CN2/RA0 2 Analog input channel 0 
AN1/VREF/CN3/RA1 3 Analog input channel 1 

PGED1/AN2/C2IN/RP0/CN4/RB0 4NC Data I/O for programming/debugging 
channel 1 

PGEC1/AN3/C2IN/PR1/CN5/RB1 5NC Clock input for 
programming/debugging channel 1 

AN4/C1IN/RP2/CN6/RB2 6 Analog input channel 4 
AN5/C1IN/RP3/CN7/RB3 7 Analog input channel 5 

VSS 8 Ground reference 
OSC1/CLKI/CN30/RA2 9 Oscillator crystal input 

OSC2/CLKO/CN29/PMA0/RA3 10 Oscillator crystal input 
SOSCI/RP4/CN1/PMBE/RB4 11 32.768 kHz low-power oscillator 

crystal input 
SOSCO/T1CK/CN0/PMA1/RA4 12 32.768 low-power oscillator crystal 

output 
VDD 13NC Positive voltage supply 

PGED3/ASDA1/RP5/CN27/PMD7/R
B5 

14* Data I/O for programming/debugging 
channel 3 

PGEC3/ASCL1/RP6/CN24/PMD6/RB
6 

15* Clock input for 
programming/debugging channel 3 

INT0/RP7/CN23/PMD5/RB7 16* External input 0 
TCK/SCL1/RP8/CN22/PMD4/RB8 17* JTAG test clock input 
TDO/SDA1/RP9/CN21/PMD3/RB9 18* JTAG test data output 

VSS 19 Ground reference 
VCAP 20 CPU logic filter capacitor 

PGED2/TDI/RP10/CN16/PMD2/RB10 21* Data I/O for programming/debugging 
channel 2 

PGEC2/TMS/RP11/CN15/PMD1/RB1
1 

22* Clock input for 
programming/debugging channel 2 

AN12/RP12/CN14/PMD0/RB12 23 Analog input channel 12 
AN11/RP13/CN13/PMRD/RB13 24 Analog input channel 11 

AN10/RTCC/RP14/CN12/PMWR/RB
14 

25 Analog input channel 10 

AN9/RP15/CN11/PMCS1/RB15 26 Analog input channel 9 
AVSS 27 Ground reference for analog modules 
AVDD 28NC Positive voltage supply for analog 

modules 
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One of the methods of sending data to a peripheral device is through pulse-width 

modulation (PWM). More specifically, PWM is frequently used to control power distribution to 

a motor. The use of PWM in an instructional environment such as a microcontrollers course is 

necessary due to the requirements of controlling such a signal. The calculations made, and also 

the hardware requirements, help the user in his or her understanding of peripheral device control. 

On the Dragon12-Plus MCU, the user is provided with eight separate PWM channels for 

use with any associated peripheral device. By making use of status, control, and data registers, 

the user is able to output a PWM signal to whatever specifications his or her application may 

require [8]. 

The PWM-controlled fan that was selected is the FFB0412VHN-TP03 fan by Delta 

Electronics. The fan itself has a rated voltage of twelve volts direct current (DC) and an average 

speed of approximately 9500 revolutions per minute. Physically, it has dimensions of 1.575 

inches (90 mm) square with a height of 1.102 inches (28 mm). This fan was chosen because of 

its relatively small physical footprint over a similar counterpart that has a physical footprint 

exactly twice its size. 

The fan has four connections provided over independently insulated leads. These 

connections are color-coded for ease of use. The leads can be seen in the image of the fan in 

Figure 14, below. The black wire is associated with the negative voltage and the red wire is 

associated with the positive voltage, +12 VDC. The blue wire provides the user with a 

tachometer output, which gives a number of pulses based on the number of rotations of the fan, 

and the yellow wire is the PWM control, effectively controlling the speed of rotation according 

to its duty cycle. Further information regarding these signals can be found in the manufacturer’s 

datasheet [19]. 



29 
 

 

Figure 14. Delta Electronics FFB0412VHN-TP03 PWM-control DC fan. 
 

A motor driver is a component that is often used in a laboratory environment regarding 

microcontroller education. A half-H driver is an IC that accepts inputs that are at transistor-

transistor logic (TTL)- and low-level complementary metal-oxide semiconductor (CMOS) logic 

levels and uses these signals to produce and control high-current and/or high-voltage loads. 

When dealing with motor applications in a peripheral device-based course, these drivers are a 

necessity. 

The comparable component on the Dragon12-Plus is the dual H-bridge that is used for 

controlling two DC motors or one Stepper motor. This component has motor feedback or an 

incremental encoder interface with quadrature output. The IC that was selected for use with the 

MCUPC is the SN754410 Quadruple Half-H Driver from Texas Instruments. This particular 

component is used in a sixteen-pin DIP that is mounted directly to the MCUPC PCB, as shown 

in Figure 15 [8]. 
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Figure 15. Texas Instruments SN754410 Quadruple Half-H Driver mounted as part of the 
MCUPC. 

 
Because there are so many different types of components loaded on the MCUPC, and due 

to the lack of physical footprint space on the PCB, only a subset of the voltages required can be 

made available in regulated voltage form. A 5V regulator was selected to provide the user with 

the capability of making use of a simple voltage regulator component package and providing a 

signal that could be used with many basic components. Since the NI ELVIS workstation, through 

the mounting headers on the outer rim of the MCUPC, offer +15V and +5V as always-available 

connections, the +5V regulator is merely a tool to assist the user when working with voltage 

regulators in a learning environment. A +3.3V regulator is also provided so that the 

microprocessor could be used separate and apart from the Microstick development kit. These 

voltages are also provided on the Dragon12-Plus MCU via the microprocessor headers [8, 20]. 

The regulators chosen are packaged in the TO-220 electronic component package. This 

package gives the user three pins for making use of the regulator. Two of the leads are the input 

and output signals of the regulators and the inner lead is the grounding reference for the 

component, along with the majority of its body. The 5V regulator from National Semiconductor 

packaged in the TO-220 is shown in Figure 16 below [21]. 
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Figure 16. National Semiconductor LM2940CT-5.0 5V regulator. 
 

A Digital-to-Analog Convertor is a component that can be used for a myriad of different 

applications, especially those in the setting of a course covering microcontrollers and peripheral 

interfacing. For audio signals and other known applications, the digital-to-analog converter 

(DAC) IC selected can be used for instructional purposes. 

The Dragon12-Plus MCU offers the user a dual 10-bit DAC for various operations with 

the Serial-Peripheral Interface (SPI) including waveform generation and audio applications. 

Perhaps the most helpful benefit of working with a DAC IC, such as this, would be the 

experience of working with SPI, a popular communication and control interface when working 

with peripheral devices [8]. 

 

Figure 17. Maxim Integrated Products MAX548ACPA+ DAC IC. 
 

Maxim Integrated Products offers the MAX548ACPA+ eight-bit low-power SPI DAC in 

an eight-pin DIP. This component package was selected because of its availability and its 

relatively small physical footprint. The component has one voltage output associated with the 

lone data converter and uses a single-supply voltage source. The pinout configuration is 

recreated from the manufacturer’s datasheet in Table 4 [22]. 
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Table 4. Pinout Diagram for the MAX548ACPA+ DAC 8-DIP IC [22]. 
 

Pin Name Pin Number Pin Description 
GND 1 Ground reference 

OUTA 2 DAC A output voltage 
CS 3 Chip-Select input 

DIN 4 Serial-Data input 
SCLK 5 Serial-Clock input 
LDAC 6 Load DAC input 
OUTB 7 DAC B output voltage 
VDD 8 Positive voltage supply 

 

Electrically Erasable Programmable Read-Only Memory (EEPROM) is a particular 

implementation of non-volatile memory that is used to retain small amounts of data in 

microcontroller systems. For an embedded system, the EEPROM that is implemented would 

likely hold configuration and startup or boot data, so that the system knows how to react when 

power is applied. Using an EEPROM component in a laboratory and/or educational setting is 

beneficial to the users’ future understanding of memory interfacing. The interfacing of this 

memory gives the user another look at the I2C interface for peripheral control. 

Microchip Technologies manufactures the 24LC515-I/P, a 400 kHz frequency EEPROM 

device that has an I2C interface and an input voltage range of 2.5V to 5.5V. This particular 

component is available in an eight-pin DIP IC that is mounted very similarly to the other 

components on board the MCUPC. 

 

Figure 18. Microchip Technologies 24LC515-I/P 512K I2C CMOS Serial EEPROM. 
 
  



33 
 

Table 5. Pinout Diagram for the Microchip Technologies 24LC515-I/P [23]. 
 

Pin Name Pin Number Pin Description 
A0 1 User-configurable chip select 
A1 2 User-configurable chip select 
A2 3 User-configurable chip select 
VSS 4 Ground reference 

SDA 5 Serial data 
SCL 6 Serial clock 
WP 7 Write-protect input 
VCC 8 Supply voltage input 

 

The pinout information is shown in Table 5. The first three pins are used for the standard 

three-bit addressing for the I2C interface. The only caveat with this IC’s addressing is that it will 

only operate when pin three (A2) is held to a logical ‘1’ state, equivalent with pin eight, or VCC. 

The remaining bits are used with the I2C interface as any other component [23]. 

One of the most widely used forms of digital output, with regard to microcontroller 

systems, is the Liquid Crystal Display (LCD) module. The character LCD screen normally has a 

proprietary input method. This makes it a helpful addition to any laboratory or educational 

system that is designed. It is also an interesting peripheral that is very popular in microcontroller 

courses. 

The LCD Module that was chosen is the Crystalfontz America CFAH1602B-TMI-JT 

Character LCD Module. The classification information from the product number gives 

information from the manufacturer’s datasheet. The module is a sixteen character by two line 

character LCD display. It uses a white light-emitting diode (LED) backlight and works with 

multiple font sets. This model can be seen in Figure 19. The pinout information for this LCD 

device is given in Table 6 from the descriptions in the manufacturer’s datasheet [24]. 
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Figure 19. Crystalfontz America CFAH1602B-TMI-JT Character LCD Module. 
 

Table 6. Pinout Diagram for Crystalfontz America CFAH1602B-TMI-JT Character LCD 
Module. [24] 

 
Pin Name Pin Number Pin Description 

VSS 1 Ground reference 
VDD 2 Supply voltage for logic 
VO 3 Supply voltage for driving LCD 
RS 4 Register selection input 

R/W 5 Read/Write control input 
E 6 Read/Write enable signal 

DB0 7 Data bit 0 
DB1 8 Data bit 1 
DB2 9 Data bit 2 
DB3 10 Data bit 3 
DB4 11 Data bit 4 
DB5 12 Data bit 5 
DB6 13 Data bit 6 
DB7 14 Data bit 7 

A (LED +) 15 Positive supply voltage for LED 
K (LED -) 16 Negative supply voltage for LED 

 

SECTION C. PCB ARTIST 

To implement the MCUPC, a suitable PCB design software suite was chosen. To decide 

on a design suite, several factors were weighed and researched. One of the major influences of 

the decision was the cost of use of the system. In order to keep cost to a minimum, keeping in 

mind the amount of components and custom orders that were to be made throughout the process, 

a free version of a PCB design software suite was needed. There exist many software systems 
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that have the capabilities necessary to complete the design in question, but a system that had 

little or no cost to the user was sought after. A system that is easy to learn and use was 

appropriate for this project. Also, a system that had been used by the Department of Electrical 

and Computer Engineering at The University of Alabama was desirable, so that no delay-time 

setting up orders would be necessary. After all factors were weighed, the PCB Artist software 

suite by Advanced Circuits was chosen. 

PCB Artist is a software program from Advanced Circuits that functions as a PCB layout 

system and schematic capture suite. The software suite includes tools for schematic capture as 

well as a PCB layout system that is integrated tightly with the circuit schematics in an associated 

project. The ordering process is also a feature that is incorporated into the design suite [25]. 

For the purposes of this system, there is little need to sketch a schematic circuit of the 

MCUPC for several reasons. The circuitry in the PCB of the MCUPC itself is limited. Most of 

the components on board the system are left unconnected due to the nature of the system being 

an educational and instructional board. The traces and routes on board the MCUPC are nothing 

more than connections between a given component and its header. Likewise, when a component 

is created within the PCB Artist program, a schematic symbol is not required. 

A screenshot of the PCB footprint layout tool is shown in Figure 20. Scaling and 

measurements can be done to any degree the user specifies, and dimensions can be calculated in 

English or metric units. The majority of the project was laid out using the millimeter as the base 

unit due to personal preference of the designer and the high precision it offered within the PCB 

Artist system. All the design parameters necessary are chosen by the user at the beginning of the 

design process. The system does have some standard default settings and parameters with regard 
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to the routing bias, trace widths and gaps, and material thickness, among others. Any of these 

parameters may be changed by the user, however, if the need were to arise [25]. 

 

Figure 20. Screenshot Revision 2.0 of the MCUPC in PCB Artist. 
 

SECTION D. REQUIRED DESIGN SPECIFICATIONS 

Several design specifications must be considered when designing a system such as the 

MCUPC. Some stipulations are more important than others, but all must be met to ensure a 

successful and functional design. 

The connection headers fitting the NI ELVIS instrumentation suite headers meet the 

requirement of two different specifications. First, the connection headers provide the same access 

to the instrumentation suite that the NI ELVIS itself would. In meeting this requirement with 

these connection headers, the advantages that the NI ELVIS workstation brings are enhanced 

with the addition of the MCUPC. Similarly, these components also serve as the main physical 

mounting points of the MCUPC. In Figure 4, a snapshot showing the overhead view of the NI 

ELVIS system is shown. The outer two rows of the instrumentation suite headers measure as 

exactly 174.5 millimeters apart. The connection headers of the MCUPC are built to these exact 
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specifications to not only mount the board in place, but also provide these connections so that the 

user may use the toolsuite offered by the NI ELVIS workstation [12]. 

A specification of the MCUPC design is that it meets certain physical footprint 

requirements. As seen in Figure 4, the instrumentation suite headers are located laterally from the 

main prototyping area. The MCUPC is meant to reside and rest over the top of this prototyping 

area, essentially replacing it in the functionality of the NI ELVIS workstation. Because of the 

components of the instrumentation suite that are housed and mounted on the PCB card of the NI 

ELVIS itself, the MCUPC must not be allowed to extend beyond the prototyping and header area 

of the workbench enough to hamper use of these tools. For these reasons, a size limitation of 8 

inches by 7 inches (203.2 millimeters by 177.8 millimeters) was used for the design of the 

MCUPC. The thickness of the board itself was left at a PCB Artist default of 0.062 inches, or 

1.575 millimeters [12, 25]. 

When designing the MCUPC, one of the main objectives was to design and assemble a 

system that would be flexible enough to meet the needs of most laboratory and instructional 

settings in which it would be used. To achieve this goal, the microprocessor unit implemented 

with this board was designed to be adaptable to the user’s needs. The microprocessor unit 

housing, shown in Figure 21, can be employed in two different ways. First, the 28-pin DIP 

microprocessor can be inserted into the inner-most sockets and connected to via the other pairs 

of sockets. Secondly, the Microstick development kit can be inserted into the second and fifth 

sockets (from top to bottom) and connected to via the outer headers only. In keeping this 

flexibility with the microprocessor unit housing, the MCUPC can be used in a variety of different 

ways, even with a family of microprocessors that the MCUPC wasn’t intended for, provided they 

are available in a 28-pin (or smaller) SPDIP package [13]. 
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Figure 21. Microprocessor unit housing on the MCUPC. 
 

SECTION E. IMPLEMENTATION 

There were some design specifications that were not hard requirements when designing 

the MCUPC. First, the components that required no physical user interactions should be placed 

and mounted toward the back of the system as the user sees it. Examples of these components are 

the CFAH1602B-TMI-JT LCD module and the various ICs that are used. Secondly, and 

similarly, the components that require a greater amount of user interaction should be laid out 

toward the outside portions of the MCUPC. This category of components would include the 

Futurlec Small Keypad, the Pololu 270-Point Breadboard, and the microprocessor unit housing. 

Using these two design principles, as well as the design requirements spoken of earlier in this 

document, Revision 1.0 of the board was designed using PCB Artist’s PCB layout software suite. 
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Figure 22. Revision 1.0 MCUPC PCB. 
 

Revision 1.0 of the MCUPC PCB can be seen in Figure 22. The connection headers on 

the outer portion of the PCB connect the MCUPC with the instrumentation suite headers on the 

NI ELVIS and also physically stabilize the PCB itself. The footprint for the Pololu 270-Point 

Breadboard is located in the upper left portion of the PCB. Just under this prototyping area is the 

footprint for the Futurlec Small Keypad and its associated header. The microprocessor housing is 

situated in the lower right portion of the PCB. These three frequent-interaction components are 

arranged on the outer portions of the PCB, which successfully meets the design goal of keeping 

the user away from the components that need no physical interaction as much as possible. Also, 

it can be noticed from Figure 22 that these components, for the most part, are directed toward the 

back and inner portions of the PCB. 

There were a number of issues with Revision 1.0 of the MCUPC that were corrected 

before the final draft of Revision 2.0 was finalized. These issues were rectified and additional 

changes made to create the PCB footprint shown in Figure 20. The final layout of Revision 2.0 

can also be seen in Appendix A. 
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Upon receipt of the manufactured Revision 1.0 boards, it was noticed that the headers did 

not easily fit into the instrumentation suite headers on board the NI ELVIS workstation. It was 

discovered that the headers were built too close together by one millimeter. The ideal spacing 

between the outer rows of each opposite header is 174.5 millimeters, as mentioned earlier in this 

document. Revision 1.0 had this dimension set at 173.5 millimeters. This was successfully 

corrected in Revision 2.0 so that the PCB could easily rest on top of the NI ELVIS workstation 

without warping of the PCB occurring [12]. 

When assembling the prototype PCB of Revision 1.0, it was apparent that errors were 

made during the creation of some custom component footprints. The mounting holes for the 

keypad, as well as the vias for the keypad, LCD module, and the voltage regulators were visibly 

too small for use. Some minor cosmetic modifications to the PCB were made using a hand drill, 

but these modifications were only temporary. Due to these fixes, it was possible to mount the 

keypad in its place. For Revision 2.0, however, these corrections were made permanent. 

Also, in Revision 1.0 of the MCUPC, the vias of the LCD module were spaced 

incorrectly from the datasheet. Last minute modifications to the LCD module physical footprint 

left the vias too close together, when they should have been spaced according to the 

manufacturer’s datasheet. This problem was also corrected in Revision 2.0 of the PCB.  
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CHAPTER 4 

INTRODUCTORY LABORATORY ASSIGNMENTS 

To begin the implementation of the MCUPC into a curriculum and a laboratory setting, a 

basis must be laid explaining the components of the laboratory that must be present. Most of the 

components that are needed in order to successfully and fully implement the MCUPC are small 

and inexpensive items available such as ICs and minor digital components. However, the NI 

ELVIS is the one major component of hardware that must be available in the laboratory. 

 The integration of the NI ELVIS system into previous courses in the ECE curriculum is a 

characteristic that the MCUPC is meant to take full advantage of. The suite of instruments that 

the NI ELVIS system offers is a basis for the MCUPC to build upon. The laboratory assignments 

that are given as examples to use when implementing the MCUPC into a department’s 

curriculum hold the prerequisite that the user has the ability to make use of the NI ELVIS 

workstation in its entirety [12, 2, 3]. 

 For the four introductory laboratory assignments that are given as examples of curriculum 

integration, there are a few main design goals and considerations that must be taken into account. 

These design considerations not only shape the format and guidelines of the laboratory 

assignments themselves, but also shape the design of the MCUPC system as a whole. With each 

assignment, there exists a set of goals that the exercises are designed to meet. The goals that are 

associated with the first four introductory laboratory assignments are general design guidelines, 

for the most part. However, the design goals and considerations are also in place to prepare the 
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student to participate and finish the more advanced laboratory assignments that are given after 

the introductory assignments are completed. 

 The laboratory assignments that are given as examples for inclusion in a laboratory 

curriculum are based on the format of a course built around the authors of [11] from their 

experience as faculty members in the Department of Electrical and Computer Engineering at 

Mississippi State University. The order of the topics in this textbook is the order that is used in 

the course curriculum for the ECE 383: Microcomputers course at The University of Alabama, 

as well as the associated course at Mississippi State University. The example laboratory 

assignments attempt to follow this same pattern as much as possible. Prerequisite knowledge of 

the ANSI-standard C programming language is assumed. 

 The first laboratory assignment, labeled “Lab 01: Introduction to National Instruments 

ELVIS workstation and MCU Peripheral Card”, addresses the basics of the laboratory setup that 

the user will see throughout the remainder of the laboratory assignments. The first goal of Lab 01 

is to introduce the user to sound practices for breadboarding digital systems. To complete the 

majority of the remainder of the laboratory assignments, the user must be well versed in the 

prototyping process of digital systems, as this is a major component of the usage of the MCUPC. 

The second goal of Lab 01 is to introduce the user to the usage of the relevant NI ELVIS 

components. These components are available to users of the workstation so that multiple 

hardware components are not needed within the laboratory space. The final goal of Lab 01 is to 

familiarize the user with the MCUPC itself. Because of the relative elementary nature of Lab 01, 

there is not a section of the textbook that this assignment is associated with. It is meant to merely 

introduce the user to a subset of the hardware and operations that he or she will be working with 

and performing. 
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 The user is first given a set of guidelines for breadboarding and prototyping digital 

systems. Because the user will spend a great deal of time working with the prototyping of these 

types of systems, ample instruction and examples must be provided to them. The NI ELVIS 

workstation offers twelve instruments for use that are normally packaged individually in a 

laboratory setting. These twelve components of the instrumentation suite are explained and 

discussed for the user. Three exercises follow that the user will complete and be checked for by 

the laboratory instructor of the course. The first exercise requires the user to connect three 

devices, two resistors and a capacitor, in the pins of the breadboard on the top of the NI ELVIS 

workstation. The user is then asked to measure certain characteristics of these components, 

including the resistance, voltage, and current. The second exercise requires the user to connect 

the two resistors used in the previous exercise in series to measure characteristics of the voltage 

divider circuit. For the third, and final, exercise of the Lab 01 assignment, the user is required to 

connect the MCUPC to the NI ELVIS prototyping area and implement a simple clock circuit 

using a 555 timer IC [12, 26]. 

 The second laboratory assignment, labeled “Lab 02: Introduction to MPLAB and the 

PIC24 Assembly Language”, continues the instruction of the basic operations that the user will 

encounter upon completing the remainder of the laboratory assignments associated with the 

course. The first goal of Lab 02 is to introduce the user to the MPLAB integrated development 

environment (IDE). This is the proprietary software that Microchip Technology uses as the 

default IDE for the Microstick development kit. The other formal goal of Lab 02 is to introduce 

the user to basic PIC24 assembly language programming as well as simple ANSI-standard C 

programming. The associated section of the course textbook that this laboratory assignment 
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corresponds with is chapter three that is titled “Introduction to the PIC24 Microcontroller 

Family” [11, 27]. 

 To begin, Lab 02 requires the user to open and become familiar with the MPLAB IDE. A 

sample program, included with the textbook along with the library header files, is to be 

assembled and stepped through using the MPLAB Simulator. During this process, the user 

should become capable of utilizing the features of program simulation and monitoring that the 

MPLAB IDE has to offer. Next, Lab 02 requires the user to write their own PIC24 assembly file, 

a simple project that merely alters the values of a few memory locations and performs some 

arithmetic calculations to verify the operation of the status register on board the microprocessor 

[27]. 

 The third laboratory assignment, labeled “Lab 03: Introduction to PCB Artist; Advanced 

Coding with MPLAB, C, and PIC24 Assembly”, addresses programming skills at the high-level, 

working with ANSI-standard C, as well as the low-level, in PIC24 assembly language. The 

assignment also introduces the user to a software tool called PCB Artist that they will utilize 

throughout the remainder of the course. Another goal of Lab 03 is to continue to reinforce the 

user’s understanding of the MPLAB IDE and programming using both ANSI-standard C and the 

PIC24 assembly language. Lab 03 covers material that is presented in chapters four and five of 

the course textbook [25, 11, 27]. 

 During Lab 03, the user is required to become familiar with the PCB Artist software 

system. More specifically, the user must create, in PCB Artist, the clock circuit built around the 

standard LM555 timer chip that he or she constructed as a part of the Lab 01 laboratory 

assignment. The user is then required to write two C source files dealing with unsigned and 

signed arithmetic operations. These files are compiled, assembled, and incrementally executed 
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using the MPLAB Simulator. Next, the user must create these two files writing in PIC24 

assembly language and step through them. Finally, the user must write a C source file and a 

PIC24 assembly file that makes use of a subroutine that will accept a sixteen-bit integer and 

return it with the least-significant and most-significant bytes swapped [25, 26]. 

 The fourth, and final, introductory laboratory assignment, labeled “Lab 04: Utilizing 

Pointers and the Stack the code in ANSI-standard C and PIC24 assembly”, is the last assignment 

that the user will be presented with dealing only with software. Once again, the MPLAB IDE 

will be used, along with the MPLAB Simulator, to further the user’s knowledge of ANSI-

standard C and the PIC24 assembly language. The first goal of Lab 04 is to introduce the user to 

coding and programming with ANSI-standard C pointers. Pointers, being an integral part of the 

C programming language, must be covered thoroughly to ensure the user’s knowledge of the 

language to a useful point. The second goal of this laboratory assignment is to allow the user to 

gain valuable experience working with the stack data structure while programming with the 

PIC24 assembly language. Lab 04 covers topics and material that is encompassed by the course 

textbook in chapters five and six [11, 27]. 

 The user is first instructed in a review of ANSI-standard C, focusing on its relationship 

with pointers, and the stack data structure from the abstract level. Next, the user is required to 

write a pair of ANSI-standard C files that will make use of C pointers in two different ways. The 

first file instantiates pointers and performs basic arithmetic operations on them using the 

dereferencing operators. The second file instantiates an array and modifies the contents of its 

elements using only pointer arithmetic and the dereferencing operator. These two files are 

compiled, assembled, and executed using the MPLAB Simulator. Then, the same objectives are 

met with two corresponding PIC24 assembly files. These files are assembled and executed using 
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the MPLAB Simulator. Finally, the user is required to write a PIC24 assembly file that makes 

use of the stack data structure by pushing and pulling values to and from it [27]. 

 These four introductory laboratory assignments are intended to assist the user in 

preparing himself or herself to continue working in the remainder of the course with a working 

knowledge of the prerequisite topics and the relevant experience that laboratory work provides. 

The assignments that are provided are examples of the types of assignments that students should 

be required to complete before moving on to the more difficult and advanced hardware-intensive 

laboratory assignments that follow. 
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CHAPTER 5 

ADVANCED LABORATORY ASSIGNMENTS 

The first four laboratory assignments, labeled as the introductory laboratory assignments, 

are comparably elementary as relating to the latter five assignments. The introductory 

assignments are meant to lay groundwork of experience and a working knowledge of the NI 

ELVIS workstation and the MCUPC, as well as the components of design and prototyping in a 

laboratory setting. These assignments require the user to complete simple tasks requiring either 

the NI ELVIS by itself or no hardware devices at all. The advanced laboratory assignments move 

the user into a further level of complexity when dealing with the set of peripherals that are 

loaded with the MCUPC. All laboratory assignments are included in Appendix B [12]. 

 The fifth laboratory assignment, labeled “Lab 05: A Simple PIC24 Digital System”, 

addresses and further reinforces the user’s knowledge of ANSI-standard C programming and 

introduces the student to working with the Microstick in conjunction with the MCUPC and the 

NI ELVIS Virtual Instrumentation suite. Chapter eight of the course textbook covers the basic 

system startup and the process of using inputs and outputs from the parallel ports on the PIC24 

microcontroller. These are the sections in the book that function as co-requisite material for the 

user while working with this laboratory assignment [11]. 

 The user is required to use the Microstick development kit to create a simple digital 

system that flashes an LED on board the device. For this first task of the assignment, the 

MCUPC is not included. This is the user’s first contact with using the Microstick development 
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kit and allows their previous work with C programming to be used. The second task of Lab 05 is 

to create, essentially, the same system while the Microstick is mounted on board the MCUPC. In 

order to integrate the Microstick into the rest of the laboratory system, the user is required to 

flash an output LED that is mounted as a part of the NI ELVIS workstation, available to the user 

only via the connection headers on board the MCUPC. 

 The sixth laboratory assignment, labeled “Lab 06: Simple I/O using the PIC24”, 

introduces the user to the design and prototyping of digital systems that implement slightly more 

complex input and output than Lab 05. The user works with polled I/O and interrupt-driven I/O 

in this assignment to meet this goal of designing more complex systems. The user’s skills in 

ANSI-standard C programming are also integral for this laboratory assignment. The associated 

section of the course textbook that this laboratory assignment corresponds with is chapters eight 

and nine. Chapter eight continues discussing the basic setup of the PIC24 microcontroller and 

parallel I/O and chapter nine introduces interrupt-based systems and basic timer devices and 

modules [11]. 

 This laboratory assignment requires the user to first implement a simple polled I/O 

system. The system utilizes the MCUPC, the Microstick, and the NI ELVIS system, as do all 

laboratory assignments from this point forward in the curriculum. The system polls a pushbutton, 

implemented by a connecting pin on the Digital Output Bus. Upon every complete button-press, 

an LED on the NI ELVIS is toggled. For the second task, the user is required to implement a 

system with similar functionality as an interrupt-based system. The press of the button in this 

case triggers an interrupt that toggles the state of the output LED. The third, and final, task of 

this laboratory assignment requires the user to implement a periodic interrupt on board this 

system for controlling the LED, eliminating the need for the pushbutton. 
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 The seventh laboratory assignment, labeled “Lab 07: Serial Communication”, introduces 

the user to the design, programming, and prototyping of digital systems that make use of some 

serial communication protocol as their primary interface. In this assignment, the user works with 

the SPI and the I2C interfaces. Two of the components on board the MCUPC are used to allow 

the student some experience with both of these popular interfacing schemes. Lab 07 covers 

material that is presented in chapter ten of the course textbook, titled “Asynchronous and 

Synchronous Serial I/O” [11]. During the course of Lab 07, the user is required to become 

familiar with the MAX548A serial 8-bit voltage-output DAC from Maxim [22]. A small digital 

circuit is constructed for the first task that implements a sinusoidal output displayed to the 

oscilloscope on board the NI ELVIS workstation. The second task requires the user to make use 

of the 24LC515 512K I2C CMOS Serial EEPROM IC from Microchip Technologies [23]. The 

user is required to create a program that performs several operations on the EEPROM, such as 

clearing, setting, and instantiating a pattern to the memory before displaying these values to the 

user. 

 The fourth advanced laboratory assignment, labeled “Lab 08: Advanced I/O using the 

PIC24 microcontroller”, allows the user to obtain more experience and a working knowledge of 

more advanced I/O-intensive applications. Throughout this laboratory assignment, the user 

designs, programs, and prototypes multiple digital systems that include fairly complex peripheral 

devices such as a twelve-button keypad and a character LCD module. Lab 08 covers topics and 

material that is not specifically encompassed by the course textbook. However, if the user is led 

through the curriculum of the course and the laboratory sessions as designed, then they will be 

well-prepared for this assignment [11]. 
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 The user is first asked to become familiar with the functionality of the Microchip 

MCP23017 16-Bit I/O Expander with Serial Interface IC [18]. The first task of Lab 08 is to 

create a three-bit wide pattern that bounces back on forth smoothly on both the LED bank of the 

NI ELVIS as well as the Digital Input Bus on the NI ELVIS workstation. Different 

configurations are used for this task, ending with the pattern bouncing on a 16-bit wide data 

location consisting of both output locations concatenated together. Task two of this laboratory 

assignment requires the user to implement a keypad counter using the Futurlec keypad and the 

Crystalfontz CFAH1602B-TMI-JT Character LCD Module as the output device [17, 24]. 

 The ninth, and final, laboratory assignment, labeled “Lab 09: Driving motors and fans 

using the PIC24”, introduces the user to the topic of driving motors and fans using the 

Microstick and the MCUPC laboratory system in tandem with the NI ELVIS workstation. The 

user makes use of a motor driver to drive a high-current DC motor and a four-wire PWM signal 

to drive a DC fan. Similar to Lab 08, Lab 09 covers material that is not specifically dealt with in 

the course textbook. However, the subject of PWM is discussed at length in chapter twelve, 

“Timers” [11]. To begin this laboratory assignment, the student is instructed on an H-bridge 

digital circuit, a circuit that allows microcontrollers to more easily and safely power high-current 

motors. The SN754410 Quadruple Half-H Driver IC from Texas Instruments is used in the first 

task of this assignment to create a circuit that powers a DC motor in multiple directions based on 

user input from the Digital Output Bus [20]. The second task of this laboratory assignment uses 

the Delta Product Groups FFB0412VHN-TP03 DC Fan [19]. This PWM-controlled device is 

driven by the user and set to different speeds at the specification of the user via the Digital 

Output Bus. A tach output is also displayed on the oscilloscope for verification purposes. 
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 These five advanced laboratory assignments are designed to instruct the users in the use 

of peripheral interfacing as it relates to microcontroller applications. The assignments discussed 

are examples of the types of assignments that can be used to meet these goals of the latter section 

of the course in question. The assignments could be modified to work with the components 

included in the initial subset of the MCUPC, or additional components could be used to compose 

new assignments, so long as the physical footprints of said devices could be made to work on 

board the MCUPC laboratory system. 
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CHAPTER 6 

IMPLEMENTATION OF MCUPC SYSTEM AND MEASUREMENT OF RESULTS 

The implementation of this system includes the purchase of all materials, the construction 

and assembly of the PCB, and the compilation of the laboratory assignments associated with the 

system. This process can be completed in a reasonable amount of time and with a reasonable 

amount of funds. All minor components of this MCUPC laboratory system can be obtained 

readily from most electronic distributors. The others are easily obtained from their respective 

manufacturers. 

The cost breakdown of all components needed for the MCUPC system to be implemented 

(not including the NI ELVIS workstation) is shown in Table 7, below. To reduce the unit cost of 

the components, and in order to estimate the cost of implementing the MCUPC system into a full 

laboratory setting, it is assumed that a quantity of components sufficient to construct five units is 

needed. It can also be noted that nearly all materials that are required for a laboratory 

assignment, and not physically located on the MCUPC itself, are not included in this 

compilation. The total cost of all items is $1063.14. 

Table 7. Cost breakdown of components for five MCUPC laboratory systems. 
 

Component Vendor/Distributor Quantity Total Cost 
Custom PCB Advanced Circuits 5 $333.63 
Breadboard Pololu 5 $16.50 

Keypad Futurlec 5 $11.00 
LCD Module Crystalfontz 5 $114.80 

Regulator (+3.3V) Digikey 5 $9.90 
Regulator (+5.0V) Digikey 5 $8.85 

DAC Digikey 5 $30.45 
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EEPROM Digikey 5 $19.70 
Fan Digikey 5 $72.50 

Driver Digikey 5 $10.70 
Microstick kit Microchip 5 $124.95 

23017 Expander Digikey 5 $7.20 
2x27 header Digikey 20 $160.20 
1x3 header Digikey 10 $4.20 
1x4 header Digikey 50 $26.00 
1x8 header Digikey 20 $15.00 
1x7 header Digikey 5 $3.40 
1x14 header Digikey 50 $58.00 
1x16 header Digikey 5 $6.25 
2x4 header Digikey 25 $21.25 

2-56 screw package Radio Shack 1 $4.28 
4-40 screw package Radio Shack 1 $4.38 

 

 Once the components are assembled, the physical construction of the MCUPC can be 

completed. The full layout of the PCB, shown in Appendix A, contains outlines and labels for all 

components. All headers are soldered directly to the PCB. The breadboard, LCD module, and 

keypad have sockets for screws of standard size 2-56. The fan contains mounting holes to be 

used with screws of standard size 4-40. Small standoffs can be optionally added under the LCD 

module and the keypad to stabilize the components for physical movement and strength. 

 The overall goals of this research are to enhance a user’s laboratory experience in an 

undergraduate course that discusses microcontrollers and their associated peripheral interfacing 

capabilities. There are multiple ways to assess this measure. The most obvious and telling of 

these are from specific assignments and associated assessments in not only the aforementioned 

course, but also subsequent courses that make use of microcontrollers and peripheral devices. At 

The University of Alabama, the courses in the undergraduate curriculum of ECE that use this 

course as a prerequisite are ECE 480/481, a Digital Systems Design course, ECE 484, a 

Computer Architecture course, and ECE 486, an Embedded Systems course. According to [1], 

ECE 480 covers design considerations and constraints, system on a chip designs, and digital 
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system design examples and applications. ECE 484 discusses “basic computer organization, 

computer arithmetic, assembly language, machine language, simple and piplelined central-

processor organization, memory system hierarchy, and measuring computer performance.” A 

description of ECE 486 mentions that the topics of coverage include hardware interfacing, 

peripheral systems, and networking. All of the topics mentioned to be covered in these courses 

require the prerequisite knowledge of microcontrollers and peripheral interfacing [2, 3]. 

 In order to assess these measures accurately, a set of data from these courses would need 

to be acquired. Ideally, assessments from these courses could be retrieved for a two- or three-

semester period to serve as a control section of data. After this is obtained, the set of students’ 

grades could be obtained from the courses after the MCUPC laboratory system has been 

implemented. Using this data, it would be evident whether the inclusion of the MCUPC into the 

laboratory curriculum was beneficial for the users and the institution’s educational goals. 

 If the MCUPC is found to improve performance, the laboratory system would be a 

needed addition to an undergraduate ECE curriculum. The MCUPC laboratory system could then 

be said to successfully meet the purposes and goals for which it was designed. 

  



55 
 

 

 

 

REFERENCES 

[1] University of Alabama Undergraduate Catalog, The University of Alabama, Tuscaloosa, AL, 
2010. 

[2] The University of Alabama. (2011, Sep.) Electrical Engineering Program 2010 Curriculum 
Flowchart. [Online]. Available: 
http://ece.eng.ua.edu/files/2011/07/EE_Flowchart_2010.pdf 

[3] The University of Alabama. (2011, Sep.) Computer Engineering Option 2010 Curriculum 
Flowchart. [Online]. Available: 
http://ece.eng.ua.edu/files/2011/07/CEO_Flowchart_2010.pdf 

[4] Bezdek, M.; Helvick, D.; Mercado, R.; Rover, D.; Tyagi, A.; Zhao Zhang; , “Developing and 
Teaching an Integrated Series of Courses in Embedded Computer Systems,” Frontiers in 
Education Conference, 36th Annual , pp. 19-24, 27-31 Oct. 2006 doi: 
10.1109/FIE.2006.322749 URL: 
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=4117237&isnumber=411683
0 

[5] Chin-Ming Hsu; Hui-Mei Chao; , “An Autonomous Mobile Robot System for Advanced 
Microcontroller Education,” INC, IMS, and IDC, 2009. NCM ’09. Fifth International 
Joint Conference on , pp. 1709-1714, 25-27 Aug. 2009 doi: 10.1109/NCM.2009.287 
URL: 
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5331305&isnumber=533129
9 

[6] Jianyun Ni; Jing Luo; , “Microcontroller-based engineering education innovation,” 
Educational and Information Technology (ICEIT), 2010 International Conference on , 
vol.3, pp. V3-109-V3-112, 17-19 Sept. 2010 doi: 10.1109/ICEIT.2010.5608413 URL: 
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5608413&isnumber=560752
5 

[7] Reese, R.B.; Jones, B.A.; , “Improving the effectiveness of microcontroller education,” IEEE 
SoutheastCon 2010 (SoutheastCon), Proceedings of the , pp. 172-175, 18-21 March 2010 
doi: 10.1109/SECON.2010.5453984 URL: 
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5453894&isnumber=545380
8 

[8] EVBplus / Wytec. (2011, Sep.). The Dragon12-Plus-USB. [Online]. Available: 
http://www.evbplus.com/9s12/9s12_hcs12.html 

[9] Grupta, G.S.; Chew Moi-Tin; , “New Frontiers of Microcontroller Education: Introducing 
SiLabs ToolStick University Daughter Card,” Sensor Networks, Ubiquitous and 
Trustworthy Computing, 2008. SUTC ’08, IEEE International Conference on , pp. 439-
444, 11-13 June 2008 doi: 10.1109/SUTC.2008.35 URL: 
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=$arnumber=4545799&isnumber=4545723 

http://ece.eng.ua.edu/files/2011/07/EE_Flowchart_2010.pdf
http://ece.eng.ua.edu/files/2011/07/CEO_Flowchart_2010.pdf
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=4117237&isnumber=4116830
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=4117237&isnumber=4116830
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5331305&isnumber=5331299
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5331305&isnumber=5331299
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5608413&isnumber=5607525
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5608413&isnumber=5607525
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5453894&isnumber=5453808
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5453894&isnumber=5453808
http://www.evbplus.com/9s12/9s12_hcs12.html
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=$arnumber=4545799&isnumber=4545723


56 
 

[10] Deaky, B.; Lupulescu, N.B.; Ursutiu, D.; , “Extended educational use of the Microcontroller 
Student Learning Kit (MCU SLK),” Global Engineering Education Conference 
(EDUCON), 2011 IEEE , pp. 913-916, 4-6 April 2011 doi: 
10.1109/EDUCON.2011.5773254 URL: 
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5773254&isnumber=577310
0 

[11] Reese, Robert, J.W. Bruce, and Bryan A. Jones, Microcontrollers: From Assembly 
Language to C Using the PIC24 Family. Boston, MA: Course Technology, 2009. 

[12] National Instruments Corporation. (2011, Sep.). Legacy NI ELVIS Replacements and 
Accessories. [Online]. Available: http://sine.ni.com/nips/cds/view/p/lang/en/nid/207242 

[13] Microstick for dsPIC33F and PIC24H Devices, Microchip Technology Inc., Chandler, AZ, 
2011. 

[14] Microchip PIC24HJ32GP302/304, PIC24HJ64GPX02/X04 AND PIC24HJ128GPX02/X04 
Data Sheet, Microchip Technology Inc., Chandler, AZ, 2007-2011. 

[15] .100” [2.54 mm] Contact Centers, Male Breakaway Header Dip Solder/Right Angle/SMT, 
Sullins Connector Solutions, Inc., San Marcos, CA, 2011. 

[16] Pololu Corporation. (2011, Sep.). 270-Point Breadboard. [Online]. Available: 
http://www.pololu.com/catalog/product/350 

[17] Technical Information – KEYPADSM, Futurlec, New York, NY, 2011. 
[18] Microchip MCP23017/MCP23S17 16-Bit I/O Expander with Serial Interface, Microchip 

Technology Inc., Chandler, AZ, 2011. 
[19] Delta Specification for Approval – DC Fan – FFB0412VHN-TP03, Delta Electronics Inc., 

2008. 
[20] SN754410 Quadruple Half-H Driver Data Sheet, Texas Instruments, Dallas, Texas, 1995. 
[21] National Semiconductor LM2940/LM2940C 1A Low Dropout Regulator Data Sheet, 

National Semiconductor Corp., Santa Clara, CA, 2007. 
[22] Maxim +2.5V to +5.5V, Low-Power, Single/Dual, 8-Bit Voltage-Output DACs in μMAX 

Package Data Sheet, Maxim Integrated Products, Sunnyvale, CA, 1997. 
[23] Microchip 24AA515/24LC515/24FC515 512K I2CTM CMOS Serial EEPROM Data Sheet, 

Microchip Technology Inc., Chandler, AZ, 2008. 
[24] Character LCD Module Specifications Revision 1.0, Crystalfontz America, Inc., Spokane 

Valley, WA, 2008. 
[25] Advanced Circuits. (2011, Sep.). Advanced Circuits PCB Artist Layout Software. [Online]. 

Available: http://www.4pcb.com/free-pcb-layout-software/ 
[26] LM555 Timer, National Semiconductor Corp., Santa Clara, CA, 2006. 
[27] Microchip Technology Inc. (2011, Sep.). MPLAB Integrated Development Environment. 

[Online]. Available: 
http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&
dDocName=en019469&part=SW007002 

  

http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5773254&isnumber=5773100
http://ieeeexplore.ieee.org/stamp/stamp.jsp?tp=&arnumber=5773254&isnumber=5773100
http://sine.ni.com/nips/cds/view/p/lang/en/nid/207242
http://www.pololu.com/catalog/product/350
http://www.4pcb.com/free-pcb-layout-software/
http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&dDocName=en019469&part=SW007002
http://www.microchip.com/stellent/idcplg?IdcService=SS_GET_PAGE&nodeId=1406&dDocName=en019469&part=SW007002


57 
 

 

 

 

APPENDIX A. REVISION 2.0 LAYOUT OF MCUPC  



58 
 

 

  



59 
 

 

 

 

APPENDIX B. COMPLETE LABORATORY ASSIGNMENTS



60 
 

ECE 383: Microcomputers – Lab 01 
Introduction to National Instruments ELVIS 
workstation and MCU Peripheral Card 
Goals: The goals of this laboratory assignment are to introduce students to guidelines and 
sound practices for breadboarding digital systems and usage of relevant National 
Instruments (NI) ELVIS components. Also, students will be introduced to the 
microcontroller unit (MCU) Peripheral Card that will be used extensively in this class. 

Introduction to Breadboarding 
 

A breadboard is a base for constructing an electronic circuit prototype. Breadboarding is a vital component to the digital 
circuit design process. It is an easy way to get a system up and running for testing and debugging purposes. In order to 
properly test and debug a system that is being designed or recreated, some good breadboarding practices must be used. A 
breadboard is simply a base component that contains a grid of contacts suitable for integrated circuits (ICs) and other 
components to be mounted (Figure 1). 

 

Figure 1. Close-up view of a small breadboard. 

In order that the debugging process stay clean and standard, some sound principles of breadboarding will be used in this 
class. The student will adhere to these guidelines when breadboarding circuit prototypes. 

1. All wiring and IC insertion should be done with no power applied to the breadboard. All connections should be 
checked before applying power to the breadboard. 

2. Use a color code convention for wires in your design. Reserve red wires for power (+5V, +3.3V, etc.) and black 
for ground. If multiple power supplies are required, green may be used for the secondary power supply (i.e. 
red=+3.3V, green=+5V). Other colors (yellow, white, blue, etc.) can be used for signal wires. 

3. Use only 22-24 gauge solid wire if possible. 22-24 gauge stranded wire that has been “thinned” with solder at the 
breadboard end may be used if necessary. 
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4. Wires should be cut to a desired length not longer than necessary. Stripping 1/4 to 3/8 inch of insulation from the 
wires and cutting the end of the wire on a 45° angle will allow for easy insertion into the breadboard. Push the 
wire as far as it will go into the breadboard to insure a good connection. Keep wires as low to the breadboard as 
feasible. 

5. Wires should be laid out such that they never cross over an IC. This will facilitate removal of ICs should it be 
necessary to do so. 

6. 1/4 watt resistors and most capacitors can usually be inserted directly into the breadboard after cutting tips to a 
45° angle. 

7. Breadboarding surfaces contain horizontal rows of connections that are typically used to distribute power to 
circuits being constructed. Use these rows to create power and ground busses for your circuit. 

8. Orient all ICs in your design in the same direction on the breadboard. We will adopt the convention such that pin 
1 of any dual-inline package (DIP) is located closest to the designer when looking at the NI ELVIS unit. 

9. Before attempting to insert an IC into the breadboard, make sure that all leads are straight. Straighten any bent 
pins with needle-nose pliers. For DIP ICs, insert one side of the IC into the breadboard, then gently insert the 
remaining side. This will minimize the possibility of bending pins when inserting ICs into the breadboard. 

10. Use on IC pullers to remove ICs from the breadboard. Using fingers or other objects increases the possibility of 
bending IC pins. 

Using these guidelines will assist the student in creating a clean and organized circuit prototype. An example of such a 
well-formed breadboard is shown in Figure 2 below. 

 

Figure 2. A well-formed and organized breadboarded circuit. 

National Instruments ELVIS usage 
 

The NI ELVIS system is a powerful tool for analog and digital circuit design. It contains a large amount of virtual tools 
and equipment that would normally be packaged individually. The system consists of a data acquisition (DAQ) card 
located in the host computer, a hardware breadboarding surface for prototyping circuitry, and the NI ELVIS software that 
serves as the user interface for the equipment. The system includes access to a set of soft front panel (SFP) instruments 
(i.e. digital multimeter (DMM), oscilloscope, etc.) to aid in testing and debugging of designs. Throughout the course, the 
student will have need of the Digital Bus Writer, the Digital Bus Reader, the DMM, the Function Generator, the 
Oscilloscope, and the Variable Power Supplies. 
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The ELVIS Instrument Launcher gives the user access to the SFP instruments in the ELVIS system. While the system is 
powered on, use the link Start (Windows, Home, etc.) → All Programs → National Instruments → NI ELVIS 
Traditional → NI ELVIS Traditional to start the ELVIS Instrument Launcher (Figure 3). 

 

Figure 3. ELVIS Instrument Launcher. 

The Digital Bus Writer, shown below in Figure 4, updates the digital output (DO) bus with user-specified values. The user 
is allowed to manually edit this 8-bit bus or select a pre-defined pattern. The Writer can continually update the DO bus 
with whatever values are currently selected or perform a one-time write. Output voltage levels of the DO bus are TTL 
compatible. The DO bus pins are available on the ELVIS Breadboard header at the back-right corner. 

 

Figure 4. Digital Bus Writer. 

The Digital Bus Reader, shown in Figure 5, reads in TTL compatible data from the digital input (DI) bus. Similar to the 
functionality of the Writer, the Reader can be set to read and update the DI bus continually or only when triggered by the 
user. The Reader can accept input from the Breadboard header on the back-right corner of the ELVIS system. 



63 
 

 

Figure 5. Digital Bus Reader. 

The Digital Multimeter is used for measuring AC/DC voltage, AC/DC current, resistance, capacitance, inductance, 
diodes, and continuity. The DMM instrument interface is shown in Figure 6, below. The DMM can accept input from the 
Breadboard header on the front-right corner of the ELVIS system, the banana clips (BNCs) located on the left side of the 
ELVIS system, or the connectors on the front panel of the workstation. 

 

Figure 6. Digital Multimeter 

The Function Generator (FGEN) interface is shown in Figure 7. This instrument is able to produce various types of 
function outputs. Standard wave types are available to generate on board and amplitude and frequency settings can be 
changed digitally or physically via the controls on the front of the workstation. The FGEN module offers all capabilities 
that would be available on a standard function generator. The signals can be used by connecting to the Function Generator 
pins on the Breadboard header located on the front-left corner of the ELVIS system. 

The Oscilloscope (SCOPE), similar to the FGEN, gives the user the capability of a standard oscilloscope as a part of the 
ELVIS package. The SCOPE has two channels and can be connected to via the BNCs or the front panel of the 
workstation. The interface for this instrument is shown in Figure 8. 
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Figure 7. Function Generator. 

 

Figure 8. Oscilloscope. 

The final instrument that the student will need to use from the ELVIS toolsuite is the set of Variable Power Supplies. The 
interface for this component is shown in Figure 9. The Variable Power Supplies can be configured manually or from this 
instrument, depending on the needs of the application. The power supply can offer voltages in the range [-12V,+12V]. 
These signals can be accessed via the pins on the Breadboard header on the front-left of the ELVIS system. 
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Figure 9. Variable Power Supplies. 

Exercise 1: 
 

The goal of this exercise is to introduce the NI ELVIS workstation and demonstrate how to measure electronic component 
properties. The SFP instruments used in this exercise include the DMM for measuring resistance and capacitance. This 
exercise requires the following components: 2.2kΩ resistor (R1), 910Ω resistor (R2), and 1μF capacitor (C). 

Insert the components into the ELVIS prototyping breadboard in such a manner that both leads are available for use. The 
alignment of the resistors does not matter. The capacitor, however, should be aligned with the positive lead to the right. 
Resistor R1 is at the bottom of the schematic in Figure 10, resistor R2 is in the center, and capacitor C is at the top. An 
example of this orientation is shown in below. 

 

Figure 10. Exercise 1 example schematic. 
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The Wikipedia entry located at http://en.wikipedia.org/wiki/Electronic_color_code contains information about the color 
coding of a resistor. Read this webpage, and then fill in the following information about the resistors R1 and R2. 

 R1 has a range of __________ Ω to __________ Ω. 

 R2 has a range of __________ Ω to __________ Ω. 

Now, you will use the DMM to test the resistance of these components. When using the DMM, the notation DMM[X] 
refers to the X operation of the DMM. 

Open the ELVIS Instrument Launcher and then the DMM, and then NULL out the system. Connect one end of a yellow 
wire to one end of R1 and the other end to the CURRENT HI connection on the Breadboard header. Connect another 
yellow wire to the other end of R1 and to the CURRENT LO connection. Use the DMM[Ω] to measure R1 and record that 
value below. Do the same for resistor R2. 

Once this process is complete, connect one end of a yellow wire to the positive lead of C and the other end to the 
CURRENT HI connection on the Breadboard header. Connect another yellow wire to the negative lead of C and to the 
CURRENT LO connection. Use the DMM[C] to measure C and record that value below. 

 R1 = __________ Ω. (2.2k Ω nominal) 

 R2 = __________ Ω. (910 Ω nominal) 

 C = __________ F. (1 μF nominal) 

Explain why the measured values may disagree with the stated values. What is the percent error from the stated value in 
all three cases? 

__________________________________________________________________________________________________ 

__________________________________________________________________________________________________ 

__________________________________________________________________________________________________ 

__________________________________________________________________________________________________ 

Exercise 2: 
 

The goal of this exercise is to build a voltage divider circuit on the NI ELVIS Breadboard. The SFP instrument used in 
this exercise is the DMM[V]. This exercise requires the following components: 2.2kΩ resistor (R1) and 910 Ω resistor 
(R2). 

Using R1 and R2, assemble the voltage divider circuit shown in Figure 11 on the NI ELVIS Breadboard. 

http://en.wikipedia.org/wiki/Electronic_color_code
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Figure 11. Voltage divider. 

Connect the input voltage, V0, to the [+5V] pin socket. Connect the common to the NI ELVIS [Ground] pin socket. Check 
the circuit, and then apply power. According to circuit theory, the output voltage V1 behaves according to Equation 1, 
below. 

𝑉1 =
𝑅2

(𝑅1 + 𝑅2)
∗ 𝑉0 

Equation 1. Voltage division. 

Using the previously measured values for R1, R2, and V0, calculate V1. Next, use the DMM[V] to measure the actual 
value of V1. 

 V1 (calculated) __________ V. 

 V1 (measured) __________ V. 

Explain how the measured voltage compares with the calculated voltage. If it differs, explain why this might be so. 

 

__________________________________________________________________________________________________ 

__________________________________________________________________________________________________ 

__________________________________________________________________________________________________ 
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Exercise 3 
 

The Microcontroller (MCU) Peripheral Card is nothing more than a printed circuit board meant to sit on top of the NI 
ELVIS Prototyping Board’s breadboarding area. The MCU Peripheral Card contains a number of hardware components 
that will be used throughout this course to allow the student to gain some experience in hardware interfacing from a 
simple microprocessor. These components include a liquid crystal display (LCD) module, a matrix-output keypad, a set of 
voltage regulators offering output voltages of +5V and +3.3V, a digital-to-analog converter (DAC), an EEPROM IC, a 
motor driver, a pulse-width-modulation (PWM) driven fan, a general I/O pin expander, and a socket for a microprocessor 
in multiple forms. Also, there is a small area defined for prototyping in a breadboard environment available. 

The headers on the outside of the Peripheral Card are designed to rest directly in the header sockets on the outer edge of 
the NI ELVIS prototyping area. See the laboratory TA for assistance with the mounting of this board on the ELVIS 
prototyping board. 

The goal of this exercise is to build a digital clock circuit on the MCU Peripheral Card breadboard using resistors, 
capacitors, and a 555 timer chip. The SFP instruments used in this exercise include the Digital Writer, the Digital Reader, 
and the Oscilloscope. This exercise requires the following components: 10kΩ resistor (RA), 100kΩ resistor (RB), 1μF 
capacitor (C), and a 555 timer chip. The MCU Peripheral Card connects directly to the NI ELVIS board, so the bank of 
eight green LEDs can be used for the output of this circuit. 

Complete the following steps to verify the operation of the LEDs as output: 

1. Wire the LEDs to the 8-bit parallel output bus sockets pins DO <0..7>. For example, connect DO 0 to the pin 
socket LED 0. 

2. Launch the NI ELVIS Instrument Launcher and select Digital Writer. 

3. After a digital pattern is set, click the green arrow to send the pattern to the parallel output port DO <0..7>, which 
in turn are passed on (via your wires) to the green LEDs. 

4. Click the red square to cease updating the port. 

5. Click the Pattern selector box to view the pattern options available. 

6. Try to output each pattern selection. 

7. Close the Digital Bus Writer. 

Once the usage of the MCU Peripheral Card is understood, the 555 timer chip can be used to act as a digital clock source. 
Complete the following steps to build and perform measurements on the 555 digital clock circuit: 

1. Using the DMM[Ω] and DMM[C], measure the component values and fill in your measurements. 

RA __________ Ω (10kΩ nominal) 

RB __________ Ω (100kΩ nominal) 

C __________ μF (1μF nominal) 

2. Build the clock circuit on the breadboard as shown in Figure 12. 
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Figure 12. 555 Timer-Based Digital Clock Circuit 

3. From the NI ELVIS Instrument Launcher, select Digital Reader, check your circuit, and enable power to the 
protoboard on the NI ELVIS workstation. The Digital Bus Reader allows the current state of the parallel input 
port to be read on demand or continuously. If the clock circuit is running correctly and continuously you should 
see the least significant bit flashing. If not, use the DMM[V] to check the voltage on the 555 pins. With the clock 
circuit running, you can now make some useful circuit measurements. The values behave according to the 
following functions. 

𝑇 = 0.695(𝑅𝐴 + 2 ∗ 𝑅𝐵) ∗ 𝐶 

Equation 3. 555 timer oscillator period. 

𝐹 =
1
𝑇

 

Equation 4. 555 timer oscillator frequency. 

𝐷𝐶 =
(𝑅𝐴 + 𝑅𝐵)

(𝑅𝐴 + 2 ∗ 𝑅𝐵)
 

Equation 5. 555 timer oscillator duty cycle. 

4. Close all SFPs and click the Oscilloscope button. 

5. Connect the breadboard CH A+ input to pin 3 of the 555 timer chip. Connect the CH A- input to ground. You 
should now observe the digital waveform on channel A of the oscilloscope. 

6. Select Trigger Source CH A. This option takes the signal from channel A, sets the Trigger Type to [Analog] and 
allows you to set the Trigger slope and Level. Set the level to +1V. 

7. Utilizing the [MEAS] option for channel A, observe the frequency in the scope window. 

8. Turn CURSORS CH A button on by clicking and dragging the cursors. 

9. Measure the period and the duty cycle.  
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10. Complete the following: 

T __________ s 

Ton __________ s 

DC __________ % 

F __________ Hz 

11. Compare the measurements with the theoretical predictions from the equations above. 

 

______________________________________________________________________________________________ 

______________________________________________________________________________________________ 

______________________________________________________________________________________________ 

Have the laboratory TA or the course instructor verify the operation of the timer circuit. Turn in the completed 
laboratory worksheet pages. Make sure student names are on the assignment.  
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ECE 383: Microcomputers – Lab 02 
Introduction to MPLAB and the PIC24 
Assembly Language 
Goals: The goals of this laboratory assignment are to introduce students to using the 
MPLAB Integrated Development Environment (IDE) and basic PIC24 assembly language 
programming. Review exercises in ANSI C programming will be executed as well. 

1. Introduction to MPLAB 

 

The MPLAB IDE is an integrated toolset offered by Microchip for use with their PIC and dsPIC microcontrollers. 
This IDE is a very powerful toolset with an extensive written library for use with Microchip’s line of 
microprocessors and microcontrollers. 

To begin, we can step through a simple assembly program that is given to us in the textbook. Listing 3.4 on page 
83 of the textbook is given to us in digital form on the CD at location \code\chap3\. Download this project folder 
to a local drive and double-click on the Microchip MPLAB Project file (mptst_byte.mcp). Note: there may be two 
files named mptst_byte in the folder; one is a project file and the other is a workspace file. You should click on 
the project file. 

MPLAB should open and display a main workspace screen similar to the one shown in Figure 1. 

 

Figure 1. MPLAB main workspace. 
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Selecting the option Build All in the Project menu will assemble the program using the predefined Assembler. 
When you receive a message in the output window saying that the build was successful, as shown in Figure 2, 
you are ready to begin stepping through your program. 

 

Figure 2. Output window display after a successful build. 

Selecting the option Program Memory in the View menu will allow you to observe the contents of the memory as 
it would currently be onboard the microcontroller that has been predefined. You can scroll through the contents 
of the memory space until the program is found. Once you have found your program, you can also pull up a 
window that contains the data memory in similar fashion using the File Registers option in the View menu. The 
Special Function Registers and Watch options can be used to monitor values during the execution of the program 
as well. Once all of these windows are open and situated on your screen, you should have a workspace similar to 
the one shown in Figure 3 below. 

 

Figure 3. MPLAB debugging workspace. 

To begin stepping through the program one line at a time, use the option Debugger->Select Tool->MPLAB SIM. 
This option begins the MPLAB simulator that will run the code one line at a time. To single-step through the 
program, use the Debugger->Step Into option or, alternatively, press the F7 key. Either of these actions will step 
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the debugger one step into the program. While you are single-stepping through the program, monitor the 
debugging windows to see how the instructions are affecting the data space of the system. 

TA Check: To verify that this task was completed, include a screenshot of the final state of the program and its 
data values in your lab report. Also include the assembly code in your lab report. Before you leave the lab, make 
sure the TA confirmed that you completed this step. 

To further verify that you understand how this operation is taking place, modify the avalue definition to be the 
number represented by the last two digits of your campus-wide identification number. Re-simulate the program 
and take another screenshot of the final state of the program and its data values. Include this, along with the 
modified assembly code, in your lab report. 

2. Introduction to PIC24 assembly language programming 

 

The MPLAB IDE is a powerful toolset that is specifically written for Microchip’s line of microcontrollers. Each 
project can be tailored to the programmer’s specifications regarding the microcontroller to be used, the compiler 
or assembler to execute, and the workspace layout to be displayed. Because there are so many options and it 
would be a burden to set these up every time a new project is made, we will create new projects by resaving old 
projects to new names. For the next assignment in this lab, keep the mptst_byte.mcp project open. Use the 
Project->Save Project As option to resave the project as a new project called arithTest. 

In this project, your assignment is to write an assembly file, arithTest.s, that will hold three words (16-bits) in 
memory, x, y, and z. At the beginning of the program, assign the value that is represented by the first four digits 
of your campus-wide identification number to the memory location represented by x. At the end of the execution 
of your program, y should contain a number that is exactly twice that of the number held in x, and z should 
contain a number that is exactly five times that of the number held in x. Using sample values, Table 1 shows an 
example of what the memory locations should hold. You should accomplish this using only the addition and 
subtraction instructions talked about in Chapter 3 of your textbook. 

Memory Location Value (in hexadecimal) 
x 0x03ef 
y 0x07de 
z 0x13ab 

 

TA Check: To verify that this task was completed, include a screenshot of the final state of the program and its 
data values after simulation in your lab report. Also include the assembly code that you wrote in your lab report. 
Before you leave the lab, be sure the TA confirmed that you completed this step. 
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3. C-to-PIC24 assembly translation 

 

For this exercise, you will be writing a simple ANSI C source file and then translating that file to PIC24 assembly. 
Therefore, your deliverables will be doubled from the previous exercises. Stepping through a C program is 
identical to the process that we have already covered. 

Write an ANSI C source file that will instantiate 5 variables: num, doubled, num2, difference, and sum. This 
program will assign to num and num2 the values represented by your birth month and day, respectively (e.g. a 
person with a December 31 birthday would assign num the value 12 and num2 the value 31). doubled will hold the 
value of num multiplied by 2, difference will hold the difference between num and num2 (alter the order of the 
operation so that the answer will be a positive value), and sum will contain the sum of num and num2. There is 
no need for printing this information to a standard output. Simply modify the numbers to their desired values, 
and end the program. 

Once this ANSI C program has been written, verified, and checked by the TA, translate its operation to PIC24 
assembly and debug its execution. You should accomplish this using only the addition and subtraction 
instructions talked about in Chapter 3 of your textbook. 

TA Check: To verify that these tasks were completed, include screenshots of the final states of the programs and 
their data values after simulation in your lab report. Also include the C and assembly code that you wrote in your 
lab report. Before you leave the lab, be sure the TA confirmed that you completed these steps.  
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ECE 383: Microcomputers – Lab 03 
Introduction to PCB Artist; Advanced Coding 
with MPLAB, C, and PIC24 assembly 
Goals: The goals of this laboratory assignment are to introduce students to the schematic 
capture tools associated with the software program PCB Artist. Also, the students should 
come away from this laboratory assignment with a greater understanding of the MPLAB 
Integrated Development Environment (IDE) and PIC24 assembly language programming. 
Advanced review exercises in ANSI C programming will be executed as well. 

1. Introduction to PCB Artist 

 

PCB Artist is a software program from Advanced Circuits that is intended as a printed circuit board (PCB) layout 
system. The software suite includes tools for schematic capture as well as a PCB layout system that is integrated 
very tightly with the circuit schematics. For our purposes at this level, we will work with only the schematic 
capture portion of these software tools. 

To introduce PCB Artist and these associated capabilities, we will use Advanced Circuits’ own tutorial videos. 
The four videos are located at http://www.4pcb.com/free-pcb-layout-software/. These videos go through the 
same material that the Design Tutorial, which can be accessed through the Help->Tutorials menu, goes through. 
Of this tutorial, complete the first two chapters. These chapters should give you sufficient knowledge to 
complete the tasks required of this course. 

TA Check: Show the TA the circuit that was completed when iterating through the Design Tutorial. This circuit 
will resemble very closely the circuit on page 30 of the Design Tutorial. A printout of this circuit will suffice as 
documentation in your Lab Report. 

Use PCB Artist’s schematic capture tools to create the digital clock circuit that was used in a previous lab. This 
circuit is given again in Figure 1. The circuit’s components correspond to the following specifications: RA is a 10 
kΩ resistor, RB is a 100 kΩ resistor, C is a 1 μF capacitor and the IC is a 555 timer chip. 

  

http://www.4pcb.com/free-pcb-layout-software/
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Figure 1. 555 Timer-Based Digital Clock Circuit 

TA Check: Show the TA the circuit you completed in PCB Artist. Include a printout of your circuit in your lab 
report. 

2. ANSI C and PIC24 assembly programming with MPLAB IDE 

 

For this task, you will create multiple C and PIC24 assembly language projects implementing unsigned and 
signed arithmetic operations. To create a new project, perform the following steps: 

- Start the MPLAB IDE. 

- Use Project->Project Wizard for the creation of an MPLAB project. 

- Select the device as the PIC24HJ64GP502. 

- Select the Active Toolsuite as the Microchip C30 Toolsuite. 

- Create a New Project File using a project filename of task1a.mcp. 

- Skip the addition of existing files to the project. 

- After the project is open, use Project->Build Options to add the directory ‘C:\microchip\include’ to the 
Include Search Path directory as shown in Figure 2. 
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Figure 2. Include Search Path options. 

- Enter the C program below and save it with the name task1a.c as a part of the project. 

#include “pic24_all.h” 
 
int main (void) 
{ 
 uint8 u8_a = 0xff; 
 uint8 u8_b = 0xff; 
 uint8 u8_c = 0x01; 
 
 if (u8_a == u8_b) 
  u8_a = u8_b + u8_c; 
 else 
  u8_a = u8_c + u8_c; 
 
 return 0; 
} 
 

- Use Project->Build All to compile and assemble the program. If the source file is not already open, 
double-click on the task1a.c source file to open it. 

- After the project is compiled and assembled, use View->Program Memory and open the program memory 
window. Scroll the window until you find your program in memory. 

- Use View->File Registers to view data memory. Scroll to location 0x800, which is where your variables will 
start. 

- Use View->Special Function Registers to view the special function registers (W0-W15, etc.). 

- Open a watch window (View->Watch) and use Add Symbol to watch variable values of the program 
variables. Use Add SFR to watch the SR (status register) special function register value. 
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- Use Debugger->Select Tool->MPLAB Sim to select the MPLAB Simulator. 

- Use Debugger->Step Into (F7) to single step into the program. Watch both the memory locations and 
watch window locations, and correlate their changing values with the instructions being executed. For all 
four of the arithmetic operations, record the value of the result and the value of the sign (Z), carry (C), 
zero (Z), and overflow (V) flags. The value of the flags can be determined from the ST register. 

TA Check: Show the TA the task 1 part a results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report. 

Create a new project named task1b.mcp. Copy the original C program to a new file named task1b.c and add that 
file to the task1b project. Modify all the program variables so they represent signed data instead of unsigned data. 
Repeat the compilation, assembly, and execution of the modified program as in part a. 

TA Check: Show the TA the task 1 part b results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report. 

Create a new project named task1c.mcp. Create a PIC24 assembly language program that implements the 
equivalent of the program in task1a.c. Assemble and execute the program as in part a. 

TA Check: Show the TA the task 1 part c results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report. 

Create a new project named task1d.c. Create a PIC24 assembly language program that implements the equivalent 
of the program in task1b.c. Assemble and execute the program as in part b. 

TA Check: Show the TA the task 1 part d results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report. 

3. ANSI C and PIC24 assembly subroutine programming with MPLAB IDE 

 

Create an MPLAB project (task2a.mcp) containing a C program (task2a.c) that contains a subroutine that accepts 
a 16-bit unsigned integer and returns the integer with the LSB and the MSB swapped. For example, the number 
0x43a6 passed as a parameter would be returned as 0xa643. 

TA Check: Show the TA the task 2 part a results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report. 

Create an MPLAB project (task2b.mcp) containing an assembly language program (task2b.s) that contains a 
subroutine that implements the equivalent of task 2 part a. 
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TA Check: Show the TA the task 2 part b results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report.  
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ECE 383: Microcomputers – Lab 04 
Utilizing Pointers and the Stack to code in 
ANSI-standard C and PIC24 assembly 
Goals: The goals of this laboratory assignment include introducing the student to coding 
and programming with pointers, a useful aspect of the ANSI-standard C programming 
language. The student will also gain valuable experience working with the stack data 
structure while programming with the PIC24 assembly language. 

1. Introduction 

 

A pointer, with respect to the ANSI-standard C programming language, is a data type whose value refers directly 
to a memory location that holds some type of data value. The information, or data, in the pointer is actually a 
memory address to a specific location in memory. When a pointer holds the address of some location, it is said to 
reference that location in memory. When the data at said location needs to be obtained, the pointer can be 
dereferenced to read the information. For this laboratory assignment, you will complete a set of exercises 
requiring you to use this principle using not only the ANSI-standard C programming language, but also using the 
PIC24 assembly language set. 

The stack is a type of abstract data structure that implements a last-in first-out (LIFO) queue. The stack can be 
implemented using any data type at the ANSI-standard C level, but is usually limited to bytes at the assembly 
level. The stack has a very limited set of operations that can be used and an even smaller set of operations that 
alter the contents of the stack itself. A push operation inserts one data value on the top of the stack. A pull or pop 
operation pulls one data value from the top of the stack. 

2. Using pointers in ANSI standard C and PIC24 assembly 

 

For the first task of this laboratory assignment, you will create multiple C and PIC24 assembly language projects 
implementing pointers and pointer arithmetic. To create a new project, perform the following steps: 

- Start the MPLAB IDE. 

- Use Project->Project Wizard for the creation of an MPLAB project. 

- Select the device as the PIC24HJ64GP502. 

- Select the Active Toolsuite as the Microchip C30 Toolsuite. 

- Create a New Project File using a project filename of task1a.mcp. 
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- Skip the addition of existing files to the project. 

- After the project is open, use Project->Build Options to add the directory ‘C:\microchip\include’ to the 
Include Search Path directory. 

Write a C program that will perform the following tasks: 

1. Declare four variables of type uint8. 

2. Declare four pointers of type uint8 and initialize them to point to the previously declared variables. 

3. Assign constant values to two of the variables, using only dereferenced pointers, and assign the other 
two variables as the sum and difference, respectively, of the first two, using only dereferenced 
pointers. 

 

- Use Project->Build All to compile and assemble the program. If the source file is not already open, 
double-click on the task1a.c source file to open it. 

- After the project is compiled and assembled, use View->Program Memory and open the program memory 
window. Scroll the window until you find your program in memory. 

- Use View->File Registers to view data memory. Scroll to location 0x800, which is where your variables will 
start. 

- Use View->Special Function Registers to view the special function registers (W0-W15, etc.). 

- Open a watch window (View->Watch) and use Add Symbol to watch variable values of the program 
variables. Use Add SFR to watch the SR (status register) special function register value. 

- Use Debugger->Select Tool->MPLAB Sim to select the MPLAB Simulator. 

- Use Debugger->Step Into (F7) to single step into the program. Watch both the memory locations and 
watch window locations, and correlate their changing values with the instructions being executed. 

TA Check: Show the TA the task 1 part a results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report. 

Create a new project named task1b.mcp. Copy the original C program to a new file named task1b.c and add that 
file to the task1b project. 

For the source file task1b.c, write a C program that will perform the following tasks: 

1. Declare and instantiate an array of variables of type uint16 with 20 elements. 

2. Using only pointer arithmetic and pointer dereferencing, populate the elements of the array with 
sequential integers, starting with the value 10 in element 0. (Hint: use a ‘for’ loop.) 

Repeat the compilation, assembly, and execution of the modified program as in part a. 
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TA Check: Show the TA the task 1 part b results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report. 

Create a new project named task1c.mcp. Create a PIC24 assembly language program that implements the 
equivalent of the program in task1a.c. Assemble and execute the program as in part a. 

TA Check: Show the TA the task 1 part c results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report. 

Create a new project named task1d.mcp. Create a PIC24 assembly language program that implements the 
equivalent of the program in task1b.c. Assemble and execute the program as in part b. 

TA Check: Show the TA the task 1 part d results including the final state of the program, data memory, and the 
watch window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include 
your source language program in your Lab Report. 

3. Using a stack data structure in ANSI standard C and PIC24 assembly 

 

Create an MPLAB project (task2.mcp) containing a PIC24 assembly program (task2.s) that declares three 16-bit 
variables (x,y,z) and one constant value (avalue). The program executes the following tasks, in order: 

1. Assign avalue to x. 

2. Assign double the value of avalue to y. 

3. Push the value of y to the stack. 

4. Add the values of x and y and place the sum in a working register. 

5. Pop the previous value off the stack and place in z. 

6. Add avalue to the current value of z. 

TA Check: Show the TA the task 2 results including the final state of the program, data memory, and the watch 
window. Use a screen capture tool to capture these windows and include them in your Lab Report. Include your 
source language program in your Lab Report.  
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ECE 383: Microcomputers: Lab 05 
A Simple PIC24 Digital System 
Goals: The goals of this laboratory assignment are to further reinforce the student’s 
knowledge and experience with ANSI-standard C and introduce the student to utilizing the 
Microstick in conjunction with the Microcontroller Unit (MCU) Peripheral Card (MCUPC) 
and the National Instruments (NI) Educational Laboratory Virtual Instrumentation Suite 
(NI ELVIS). 

1. Simple programming with the Microstick 

 

For the first task of this laboratory assignment, you will use the Microstick development kit to create a basic 
digital system that will make use of basic ANSI-standard C programming. To create a new project, perform the 
following steps: 

- Start the MPLAB IDE. 

- Use Project->Project Wizard for the creation of an MPLAB project. 

- Select the device as the PIC24HJ64GP502. 

- Select the Active Toolsuite as the Microchip C30 Toolsuite. 

- Create a New Project File using a project filename of task1.mcp. 

- Skip the addition of existing files to the project. 

- After the project is open, use Project->Build Options to add the directory ‘C:\microchip\include’ to the 
Include Search Path directory. 

Write a C program that will be downloaded to the Microstick device. The program will perform the following 
tasks: 

- Set up a basic timer using the function configClock() that is included with the library source files. 

- Initialize the output pin using one of the CONFIG_RB15_AS_DIG_OUTPUT() macro functions. 

- Toggle the specified pin using a software loop to delay. The predefined DELAY_MS() function can be 
used here. 

Once this program is built, use the Debug selections of Program and Run, to download the machine code to the 
Microstick device and execute the code, respectively. 

The LED1 light should flash at the rate of your software delay. 
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TA Check: Show the TA the task 1 results including the hardware implementation and the running process in 
MPLAB. Use a screen capture tool to capture the window and include it in your Lab Report. Also include your 
source language program in your Lab Report. 

2. Flashing an LED with the Microstick 

 

For the second part of your laboratory assignment, you will implement the same program as task 1 with a slightly 
different digital system application. While task 1 was implemented solely with the Microstick as the physical 
hardware, task 2 will implement the flashing LED concept while making use of the MCUPC and the NI ELVIS 
toolsuite. 

In order to map this program to the MCUPC, making use of LED0 on the NI ELVIS system, you should not be 
required to make any changes whatsoever to the C program itself. Using the schematic for the Microstick and its 
associated socket, route the output signal from the correct pin on the MCUPC to the header connection for 
LED0. 

TA Check: Show the TA the task 2 results including the hardware implementation and the running process in 
MPLAB. Use a screen capture tool to capture the window and include it in your Lab Report. Also include your 
source language program in your Lab Report.  
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ECE 383: Microcomputers – Lab 06 
Simple I/O using the PIC24 
Goals: The goals of this laboratory assignment are to introduce students to the design and 
prototyping of digital systems that implement simple types of input and output for the user. 
The user will work with an I/O system that implements a polled interface and also multiple 
types of interrupt-based interfaces. ANSI-standard C programming will be used toward these 
ends. 

1. Implementing a simple polled I/O system 

 

Polling refers to the process of constantly testing a port (or pin, connection, lead, etc.) to obtain new data. When 
using a system that works with polled input, you run the risk of creating a system that starves any other items 
that may need to execute. However, this is the most basic type of I/O and is fairly simple to implement. When 
working with a system that has very few objectives and is not I/O intensive, polling can be a usable option. 

For task 1 of this laboratory assignment, you will implement a simple digital system using the MCUPC, the 
Microstick, and the NI ELVIS system that will toggle an LED with every complete press of a pushbutton, 
implemented by the Digital Output Bus on the NI ELVIS workstation. 

In order to create a new project, perform the following steps: 

- Start the MPLAB IDE. 

- Use Project->Project Wizard for the creation of an MPLAB project. 

- Select the device as the PIC24HJ64GP502. 

- Select the Active Toolsuite as the Microchip C30 Toolsuite. 

- Create a New Project File using a project filename of task1.mcp. 

- Skip the addition of existing files to the project. 

- After the project is open, use Project->Build Options to add the directory ‘C:\microchip\include’ to the 
Include Search Path directory. 

Write a C program that will be downloaded to the Microstick device that will meet the following objectives: 

- Digital Output 0 (DO0) will serve as the input pushbutton. An input of 0 represents the “not pressed” 
(off) state and an input of 1 represents the “pressed” (on) state. A full press is recognized when the button 
transitions from “off” to “on” and then transitions from “on” back to “off” again. 

- The output will make use of LED1 on the MCUPC/NI ELVIS workstation. This output will initialize to an 
“off” state, and will toggle each time a full button press of the input is recognized. 
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- An enumerated type definition will be used to represent the different states of the FSM. The states will be 
“STATE_RESET”, “STATE_WAIT_FOR_PRESS”, and “STATE_WAIT_FOR_RELEASE”. 

 
- A looping algorithm that determines which of these states are currently in use will be used to trigger the 

output. 

Implement this digital system on the MCUPC using the Microstick and the headers to the NI ELVIS toolsuite. 

TA Check: Show the TA the task 1 results including the hardware implementation and the running process in 
MPLAB. Use a screen capture tool to capture the window and include it in your Lab Report. Also include your 
source language program in your Lab Report. 

2. Implementing a simple interrupt-based I/O system 

 

For task 2 of this laboratory assignment, you will implement a simple digital system that will function exactly as 
task 1 did, but using an interrupt-driven system instead of polled I/O. In order to create a new project, perform 
the steps from the list in the task 1 instructions, using task2.mcp as the filename for the project file. 

Write a C program that will be downloaded to the Microstick device that will meet the following objectives: 

- Digital Output 0 (DO0) will serve as the input pushbutton. An input of 0 represents the “not pressed” 
(off) state and an input of 1 represents the “pressed” (on) state. A full press is recognized when the button 
transitions from “off” to “on” and then transitions from “on” back to “off” again. 

- The output will make use of LED1 on the MCUPC/NI ELVIS workstation. This output will initialize to an 
“off” state and will toggle each time a full button press of the input is recognized. 

- One complete press of the “pushbutton” will trigger an interrupt. The ISR for this interrupt will do 
nothing more than toggle the output. Time must never be wasted in an interrupt service routine (ISR). 

Implement this digital system on the MCUPC using the Microstick and the headers to the NI ELVIS toolsuite just 
as done in task 1 of this laboratory assignment. 

TA Check: Show the TA the task 2 results including the hardware implementation and the running process in 
MPLAB. Use a screen capture tool to capture the window and include it in your Lab Report. Also include your 
source language program in your Lab Report. 

3. Implementing a simple periodic-interrupt-based I/O system 

 

For task 3 of this laboratory assignment, you will implement a simple digital system that will function in a similar 
fashion to the flashing LED system from Lab 05. However, while Lab 05’s assignment asked you to implement 



87 
 

this using a software delay, you will now implement this functionality using a periodic delay based on the Timer 
3 module of the PIC24HJ64GP502 microcontroller. 

A sequence of instructions that will configure the Timer 3 module to your exact specifications will be needed and 
will look similar to the instructions here: 

T2CONbits.T32 = 0; 
T3CON = 0x0030; 
PR3 = <some calculation>; 
TMR3 = 0; 
_T3IF = 0; 
_T3IP = 1; 
_T3IE = 1; 

Additional instructions will be needed to enable and disable the timer module, as well as implement the ISR for 
it, but these instructions should provide a base for you to get started. 

The periodic timer should toggle the LED once every 0.5 seconds, or a frequency of 1 Hz. 

TA Check: Show the TA the task 3 results including the hardware implementation and the running process in 
MPLAB. Use a screen capture tool to capture the window and include it in your Lab Report. Also include your 
source language program in your Lab Report.  
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ECE 383: Microcomputers – Lab 07 
Serial Communication 
Goals: The goals of this laboratory assignment are to introduce students to the design, 
programming, and prototyping of digital systems that make use of serial communication 
with other devices through different types of serial communication interfaces. The student 
will work with the serial-peripheral interface (SPI) as well as the Inter-Integrated Circuit 
(I2C) interface by implementing systems making use of separate integrated circuits (ICs). 

1. Using SPI to make use of a digital-to-analog converter (DAC) IC 

 

The MAX548A serial 8-bit voltage-output DAC is an IC from Maxim that functions by way of the SPI. The pinout 
diagram can be seen in the recreated Figure 1, below. Alternatively, the datasheet can be viewed at 
http://datasheets.maxim-ic.com/en/ds/MAX548A-MAX550A.pdf. This datasheet contains invaluable information 
regarding the functionality of the IC itself. 

 

Figure 1. Pinout diagram for Maxim MAX548A serial 8-bit voltage output DAC. 

For the first task of this laboratory assignment, you will need two 10 kΩ potentiometers. These pieces of 
equipment are not mounted on board the MCUPC or the NI ELVIS workstation, so secure the components 
before moving forward with the assignment. 

Figure 11.36 in the textbook shows the basic physical configuration for connecting the MAX548A DAC to the PIC 
microcontroller via SPI. Keep in mind, that this microcontroller identified in the text is not the same 
microcontroller that is loaded on the Microstick by default. Minor changes may or may not be necessary. 

Using this digital circuit and your code, implement a sinusoidal output to the oscilloscope through the headers 
on board the MCUPC. Once this circuit is functioning, you can view the sinusoid on the digital tool by 
completing the following steps: 

- Select the start or home button in the lower-left corner of the screen. 

- Choose All Programs. 

http://datasheets.maxim-ic.com/en/ds/MAX548A-MAX550A.pdf
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- Navigate through the folders National Instruments and NI ELVIS Traditional. 

- Select NI ELVIS Traditional. You will bring up the screen shown below. 

 

Figure 2. NI ELVIS Virtual Instrument Launcher home screen. 

- Choose Oscilloscope to bring up the oscilloscope tool shown in Figure 3. 

 

Figure 3. Oscilloscope tool from NI ELVIS Virtual Instrument Launcher. 

Using the oscilloscope, take snapshots of the tool so that at least two full periods of the sinusoid is visible in the 
sampling window. Calculate the frequency and period of the waveform and include this data in your Lab Report. 
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TA Check: Show the TA the task 1 results including the hardware implementation and the functioning 
oscilloscope tool displaying the waveform. Use a screen capture tool to capture the window and include it in 
your Lab Report. Also include your source language program and your own custom schematics of the digital 
system in your Lab Report. 

2. Using I2C to make use of an electronically erasable programmable read-only 
memory (EEPROM) 

 

The 24LC515 512K I2C CMOS Serial EEPROM from Microchip is a device that functions as user-controlled read-
only memory. This memory can be erased and written over many times (on the order of a million writes in the 
lifetime of the device). 

For the second task in this laboratory assignment, you will create a digital system that will make use of the 
EEPROM IC. The pinout diagram for the device is shown below in Figure 1. 

 

Figure 1. Pinout diagram for Microchip 24LC515 512K I2C CMOS Serial EEPROM IC. 

The MPLAB project in the textbook’s code named mcp24lc515_i2c_eeprom.mcp can be used to begin this task of 
Lab 07. Your project should perform the following tasks, in the order that they are listed: 

- Clear all data locations. 

- Display all (cleared) locations to the bootloader. The data should be printed as an address and a data 
section. 

- Set all bits in the EEPROM by writing 0xff to every memory address. 

- Display all (set) locations to the bootloader as in step 2. 

- Print a pattern of your CWID to the memory locations of the upper half of the EEPROM, in succession. 
Print a pattern of your numeric birthdate (12 31 85) for December 31, 1985, to the lower half of the 
EEPROM, in succession. 

- Display all locations to the bootloader as in step 2. 

TA Check: Show the TA the task 2 results including the hardware implementation and the printed sets of data 
(all three). Use a screen capture tool to capture the displayed sets of memory data and include these images in 
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your Lab Report. Also include your source language program and your own custom schematics of the digital 
system in your Lab Report.  
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ECE 383: Microcomputers – Lab 08 
Advanced I/O using the PIC24 microcontroller 
Goals: The goals of this laboratory assignment are to allow the students to have more 
experience and a working knowledge of more advanced I/O intensive applications. The 
student will design, program, and prototype multiple digital systems that include more 
complex I/O peripheral devices such as a matrix-output keypad and a character liquid 
crystal display (LCD) module. 

1. Microchip MCP23017 16-Bit I/O Expander with Serial Interface 

 

The Microchip MCP23017 16-Bit I/O Expander with Serial Interface is an IC that functions via the I2C interface 
that you have worked with in previous assignments. The pinout diagram of this device can be seen below in 
Figure 1. The datasheet can be viewed at http://ww1.microchip.com/downloads/en/DeviceDoc/21952b.pdf, 
alternatively. This document contains invaluable information regarding the functionality of the device. 

 

Figure 1. Pinout diagram for Microchip MCP23017 16-Bit I/O Expander with Serial Interface. 

For the first task of this laboratory assignment, you will design, program, and prototype a digital system that will 
make use of the pin expander IC mentioned in this document. All equipment that you will need is included in 
the composite system of the MCUPC and the NI ELVIS workstation, not including the connecting wires 
necessary. 

Use this device to create a three-bit wide pattern that will bounce back and forth smoothly on the LED bank of 
the NI ELVIS workstation. The only I/O pins that should be used on the microcontroller are the SCL and SDA 
pins related to the I2C interface. All eight LEDs should be driven by the MCP23017 IC. Additionally, eight more 
outputs of the MCP23017 device should be connected to the Digital Input Bus on board the NI ELVIS 
workstation. Hold these values high while the bouncing pattern is functioning on the LEDs. The Digital Input 
Bus can be viewed by loading the Digital Reader from the NI ELVIS Virtual Instrument launcher. 

http://ww1.microchip.com/downloads/en/DeviceDoc/21952b.pdf
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TA Check: Show the TA the task 1 part a results including the hardware implementation and the functioning 
output displays. Use a screen capture tool to capture the Digital Reader display and include it in your Lab Report. 
Also include your source language program and your own custom schematics of the digital system in your Lab 
Report. 

For part b of task 1, you will swap the functionality of the Digital Reader outputs and the LEDs. Hold the LEDs 
high (“on”) while the bouncing pattern functions on the Digital Input Bus. 

TA Check: Show the TA the task 1 part b results including the hardware implementation and the functioning 
output displays. Use a screen capture tool to capture multiple Digital Reader screenshots showing the 
functioning bouncing pattern and include these in your Lab Report. Also include your source language program 
and your own custom schematics of the digital system in your Lab Report. 

For part c of task 1, you will implement a three-bit bouncing pattern on the LEDs and the Digital reader 
concatenated together. The Digital Input Bus represents the most significant byte of the output and the LEDs 
represent the least significant byte. The three-bit bouncing pattern should bounce from one end of the LEDs to 
the opposite end of the Digital Input Bus. 

TA Check: Show the TA the task 1 part c results including the hardware implementation and the functioning 
output displays. Use a screen capture tool to capture multiple Digital Reader screenshots showing the 
functioning bouncing pattern and include these in your Lab Report. Also include your source language program 
and your own custom schematics of the digital system in your Lab Report. 

2. Futurlec small keypad and Crystalfontz CFAH1602B-TMI-JT Character LCD 
Module 

 

The Futurlec small keypad is a device that functions as a twelve-input (four rows by three columns) keypad. It 
uses a keypad-standard matrix output that can be seen in the datasheet. This document can be found at the 
following address: http://www.futurlec.com/KeypadSm.shtml. 

The Crystalfontz CFAH1602B-TMI-JT Character LCD Module is a device that displays output to a sixteen 
character by two row LCD screen. The pinout diagram for this device can be seen below in Figure 2. 
Alternatively, the datasheet can be viewed at http://www.crystalfontz.com/product/CFAH1602BTMIJT. 

http://www.futurlec.com/KeypadSm.shtml
http://www.crystalfontz.com/product/CFAH1602BTMIJT


94 
 

 

Figure 2. Pinout diagram for Crystalfontz CFAH1602B-TMI-JT Character LCD Module. 

For task 2 of this laboratory assignment, you will implement a digital system including the keypad and the LCD 
module that will operate as a counter. The display should read: 

  The count is 
currently: 0x00. 

The count should be initialized to 0x00. With every press of a button on the keypad, the associated value should 
be added to the running count and the display updated accordingly. The ‘*’ button should be treated as an 
additional zero value. In other words, nothing should happen when this button is pressed. The ‘#’ button should 
be treated as a count reset to zero. 

TA Check: Show the TA the task 2 results including the hardware implementation and the functioning system. 
Include your source language program and your own custom schematics of the digital system in your Lab Report.  
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ECE 383: Microcomputers – Lab 09 
Driving motors and fans using the PIC24 
Goals: The goals of this laboratory assignment are to introduce students to the topic of 
driving motors, as well as other devices, such as fans, by using the PIC24 microcontroller. 
The student will make use of a motor driver IC to drive a high-current DC motor and a four-
wire pulse-width modulation interface to drive a DC fan. 

1. Texas Instruments SN754410 Quadruple Half-H Driver 

 

An H-bridge is a configured digital circuit that can allow microcontrollers to power high-current motors. The 
circuit operates as a switch, allowing the large amount of current to flow or cutting it off, without having to deal 
with the signal on board the microcontroller itself. This can save much energy and equipment when used 
correctly.  

The SN754410 Quadruple Half-H Driver from Texas Instruments is a device that can be used as multiple 
instantiations of the Half-H driver digital circuit. The pinout diagram for this device can be seen below in Figure 
1. The datasheet can be found at http://www.ti.com/lit/ds/slrs007b/slrs007b.pdf. The DC motor that will be used 
for this assignment is not implemented on board the MCUPC, so be sure to obtain a motor before proceeding 
with this assignment. We will implement only half of the functionality of the IC, so one motor is sufficient per 
student. 

 

Figure 1. Pinout diagram for Texas Instruments SN754410 Quadruple Half-H Driver IC. 

First, connect pins 4, 5, 12, and 13 to ground by way of the headers on board the MCUPC. All four pins must be 
grounded before the IC will operate normally. Pin 1 should be connected to a pin on the Digital Output Bus, so 
that the motor can be enabled and disabled by the user directly. Pins 3 and 6 (1Y and 2Y) will serve as the output 
for the motor. A high value on pins 2 or 7 will apply current to the motor for the clockwise, or counter-clockwise, 

http://www.ti.com/lit/ds/slrs007b/slrs007b.pdf
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direction, respectively. Your system should use a second set of inputs from the Digital Output Bus to allow the 
user to determine in which direction to apply current. 

TA Check: Show the TA the task 1 results including the hardware implementation and the user controls. Include 
your source language program and your own custom schematics of the digital system in your Lab Report. 

2. Pulse Width Modulation and the Delta FFB0412VHN-TP03 DC Fan 

 

The Delta Product Groups FFB0412VHN-TP03 DC Fan has a four-wire interface that works using the process of 
pulse width modulation (PWM). The four signals that are used in this interface are listed with their descriptions, 
below, in Table 1. 

Table 1. Pin descriptions for Delta Product Groups FFB0412VHN-TP03 DC Fan. 

Pin Name Pin Type Wire Color Pin Description 
Negative Voltage Input Black Common ground 
Positive Voltage Input Red +12 VDC 

Tach Output Blue Generates a tach output described below 
PWM Control Input Yellow PWM signal with frequency between 30 Hz and 30 kHz 

 

As can be seen from Table 1, above, the fan in question accepts a positive voltage of +12 VDC. This voltage value 
can be obtained from the variable power supply on board the NI ELVIS workstation and accessible through the 
headers on board the MCUPC. A set of ground pins are available on these headers as well, for the negative 
voltage. 

The PWM Control signal is the only other signal that you will need to drive yourself. The Digital Output Bus will 
be used as an 8-bit input representing the percentage duty cycle to drive the signal. A value of 0xff from the user 
represents a PWM signal of 100% duty cycle. Likewise, a value of 0x00 from the user represents a PWM signal of 
0% duty cycle. The speed, in RPM, of the fan with respect to different PWM Control signals is explained in the 
datasheet located at the following web address hosted by the manufacturer: http://www.delta-
america.com/Products/FanUploads/Specification/FFB0412VHN-TP03%28REV00%29.pdf. Use caution when 
driving the signal to ensure that the signal’s frequency is within the specified bounds. 

 

Figure 2. Output circuit for Tach output from FFB0412VHN-TP03 DC Fan. 

http://www.delta-america.com/Products/FanUploads/Specification/FFB0412VHN-TP03%28REV00%29.pdf
http://www.delta-america.com/Products/FanUploads/Specification/FFB0412VHN-TP03%28REV00%29.pdf
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The Tach output of the fan is used in some applications regarding temperature and noise control. Feedback on 
the speed is given to the user in the form of this signal. Figure 2, above, shows the recommended circuit 
organization for this signal’s reception. The FG signal (frequency generator signal) is the output that provides 
this information to the user, more thoroughly explained in the manufacturer’s datasheet. 

For the second task of this laboratory assignment, you will create a system that implements a digital circuit that 
makes use of this DC fan being controlled and analyzed in the way that is described above. All values given by 
the user should alter the speed of the DC fan in the expected way. The Tach output should be displayed on the 
oscilloscope tool provided as a part of the NI ELVIS workstation. 

TA Check: Show the TA the task 2 results including the hardware implementation and the oscilloscope images 
for the values of 0%, 25%, 50%, and 100% duty cycle PWM signals. Use a screen capture tool to capture the 
displayed images from the oscilloscope and include these images in your Lab Report with sufficient explanation. 
Also include your source language program and your own custom schematics of the digital system in your Lab 
Report. 
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